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1  Change history
Product
version

Operating Instructions Changes Comments

2.11.xx SD01928S/04/EN/01.17 Documentation separated into Operating
Instructions and Special Documentation

-

2.12.xx SD01928S/04/EN/02.17 New product version
Section 12 "HART via SFG250 Ethernet
gateway"
Section 31 "PROFIBUS via SFG500 with
Heartbeat verification DTM"

-

2.13.xx SD01928S/04/EN/03.18 New product version -

2.13.xx SD01928S/04/EN/04.18 Changes Removed I/O-Link
topic
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2  Document information

2.1  Document function
This tutorial assumes that FieldCare has been correctly installed according to the
instructions in the Getting Started manual, and that the appropriate DTM catalog has been
installed and updated. The manual describes a number of use cases with various system
architectures. It is assumed that all devices and system components are installed and
connected according to the instructions in the associated Operating Instructions.

For detailed information on " FieldCare installation": Getting Started →   11

Where equipment is to be configured in explosion hazardous areas, it must be ensured all
components, including computer, have the appropriate certification.

2.2  Symbols used

2.2.1  Safety symbols

Symbol Meaning

DANGER

DANGER!
This symbol alerts you to a dangerous situation. Failure to avoid this situation will result in
serious or fatal injury.

WARNING

WARNING!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can result in
serious or fatal injury.

CAUTION

CAUTION!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can result in
minor or medium injury.

NOTICE

NOTE!
This symbol contains information on procedures and other facts which do not result in
personal injury.

2.2.2  Symbols for certain types of information

Symbol Meaning

Permitted
Procedures, processes or actions that are permitted.

Preferred
Procedures, processes or actions that are preferred.

Forbidden
Procedures, processes or actions that are forbidden.

Tip
Indicates additional information.

Reference to documentation

A Reference to page

Reference to graphic

Notice or individual step to be observed

1. , 2. , 3.… Series of steps
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Symbol Meaning

Result of a step

Help in the event of a problem

Visual inspection

Operation via local display

Operation via operating tool

Write-protected parameter

Symbol Meaning Symbol Meaning

Permitted
Procedures, processes or actions that
are permitted.

Preferred
Procedures, processes or actions that
are preferred.

Forbidden
Procedures, processes or actions that
are forbidden.

Tip
Indicates additional information.

Reference to documentation A Reference to page

Reference to graphic 1. , 2. , 3.… Series of steps

Result of a step Visual inspection

2.2.3  FieldCareIcons

Previous symbol Current symbol Meaning

Start new project.

Open existing project.

Save open project.

Print open project.

Open clipboard.

Show DTM catalog.

Open documentation for selected device or detailed device
information.

Open inventory.

Activate protocol.

Add new device to the network.

Remove device from the network.
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Previous symbol Current symbol Meaning

Create new network topology using CommDTM and DeviceDTMs.

Compares the network topology in the field with the actual
physical network, and devices are added to the existing network.

Scans the preconfigured topology and shows the report with the
scanned device information.

Indicates whether there is a connection with the device.

Transfer information from the device to FieldCare.

Transfer information from FieldCare to the device.

Device-specific functions for the selected device.

Add plant level.

Add item.

Remove plant level.

Remove item.

Open device checklist to show selected devices in the plant.

Confirm replaced device.

New icons

Disconnected  1)

Set up communication, ready for communication  1)

Communication channel occupied or communication action
canceled. 1)

Connected 1)

W@M symbol, appears in the start bar on the bottom right if a
connection to W@M has been established.

Switch on touch mode

Switch off touch mode

1) Status indicator: online/offline status indication of devices in the plant and network view

2.3  Text emphasis

Emphasis Meaning Example

Bold Keys, buttons, program icons, tabs, menus,
commands

Start → Programs → Endress+Hauser
In the File menu, select the Print option.

Angle brackets Variables <DVD drive>



Tutorial for FieldCare projects Document information

Endress+Hauser 11

2.4  Acronyms used

Acronyms Meaning

CDI Common Data Interface

COM Communication Equipment

CommDTM Communication Device Type Manager

CSV Character Separated Value

DTM Device Type Manager

DP Decentralized Peripheral

FDT Field Device Tool

FIFO First In First Out

HART Highway Addressable Remote Transducer

I/O Input/Output

IP Internet Protocol

ISS Internal Service Interface

LAN Local Area Network

LAS Link Active Scheduler

MUX Muliplexer

NIC Network Interface Card

PA Process Automation

PC Personal Computer

PCD PROCENTEC Communication Driver

PCI Peripheral Component Interconnect

PCIe Peripheral Component Interconnect express

DCS Distributed Control System

PROFIBUS Process Field Bus

PROFINET Process Field Network

SPL Second Program Loader

PLC Programmable Logic Controller

TCP Transmission Control Protocol

UDP User Datagram Protocol

USB Universal Serial Bus

2.5  Documentation
FieldCare SFE500
• Operating Instructions BA00065S/04/EN
• Getting Started KA01303S/04/EN

Field Controller SFC162
Operating Instructions BA00069S/04/EN

Fieldgate FXA520
Operating Instructions BA00051S/00/EN

Fieldgate FXA720
Operating Instructions BA00030S/04/EN

Commubox FXA191
Safety Instructions XA000058F/00/A6
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Commubox FXA195
Safety Instructions XA00336F/00/A3

WirelessHART Adapter SWA70
Operating Instructions BA00061S/04/EN

WirelessHART Fieldgate SWG70
Operating Instructions BA00064S/04/EN

2.6  Registered trademarks
PROFINET® is a registered trademark of the PROFIBUS User Organization, Karlsruhe/
Germany.

PROFIBUS® is a registered trademark of the PROFIBUS User Organization, Karlsruhe/
Germany.

FOUNDATIONTM Fieldbus is the trademark of the FieldComm Group, Austin, TX 78759,
USA.

HART®, WirelessHART® is the registered trademark of the FieldComm Group, Austin, TX
78759, USA.

Ethernet/IP is the registered trademark of ODVA, Michigan USA.

Modbus is the registered trademark of Modicon, Incorporated.

All other brand and product names are trademarks or registered trademarks of the
companies and organizations in question.
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3  FieldCare project

3.1  Creating a project
The first steps in creating a project are always identical. The FieldCare dialog appears
by default; this can be deactivated under Extras → Options → Project. The FieldCare
dialog is no longer displayed if the None check box is checked.

Creating a project
1. Open FieldCare.

 The "FieldCare" dialog opens.

2. On the "New" tab, select the Create Project item and click Open.
 FieldCare opens a new project with a host PC.

3.2  Saving a project
FieldCare projects are stored in a database but are not accessible as files on the hard
disk. It is possible to access these files by using FieldCare in file mode. All projects are
saved in the same manner.
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Saving a project
1. Select File → Save As.

 The Save Project As dialog opens.

2. Enter a project name and click Save.
 The project is saved.

3.3  Opening a saved project
Opening a saved project
1. In the FieldCare dialog, click the Existing tab.

 The "Open Project" dialog opens. The last projects to be opened are displayed.

2. Select Project and click Open.
 The project is displayed.

If the project does not appear on the screen, click View → Network.
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4  HART point-to-point connection via
Commubox FXA191

4.1  Use cases
The Commubox FXA191 provides a direct connection between a HART device
(4 to 20 mA) and the RS232C port (COM port) of a computer. To establish communication
with the HART device, a resistor of at least 250 Ω must be provided in the circuit. The way
in which this is done depends upon the system architecture and power source used.

To see the HART device, FieldCare requires:
• HART CommDTM
• HART DeviceDTMs

Observe the maximum total load of the smart transmitter!

LWARNING
A Commubox FXA191 from a non-Ex installation is used in an Ex installation.
Malfunction due overloaded protective circuits.
‣ A Commubox FXA191 from a non-Ex installation may not be used in an Ex installation.

For detailed information on "Commubox FXA191": Safety instructions →   11

4.1.1  Loop power from controller/field device

+

–

+

–

3 51 2 4

 1 Operation of Commubox FXA191 in a control loop (I/O card active/device passive or vice versa) Via a
resistor ≥ 250 Ω (recommended 270 to 330 Ω) in the control loop

1 I/O card PLC/DCS passive or active
2 Commubox FXA191
3 RS232C
4 FieldCare
5 Field device passive or active
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+

–
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–
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 2 Operation of a Commubox FXA191 in a control loop (I/O card active/device passive or vice versa). In the
control loop (loop-resistance ≥250 Ω)

1 I/O card PLC/DCS passive or active
2 Commubox FXA191
3 RS232C
4 FieldCare
5 Field device passive or active

4.1.2  Loop power from a transmitter power supply

1 2 3 4 5 6

=

+

–

+

–

+ –

 3 Operation of Commubox FXA191 in a control loop powered by a transmitter power supply. From the
control room via the communication sockets of the transmitter power supply.

1 Active power supply (RNS221, RN221N-A, RN221N-B (Ex), RMA422, RMA42)
2 Commubox FXA191
3 RS232C
4 FieldCare
5 I/O card PLC/DCS passive
6 Field device (passive)

=

+

–

+

–

+ –

1 2 3 4 5 6

 4 Operation of Commubox FXA191 in a control loop powered by a transmitter power supply. Via the resistor
≥ 250 Ω (recommended 270 to 330 Ω) in the control loop (communication resistor of Commubox FXA191
off)

1 Active power supply (RNS221, RN221N-A, RN221N-B (Ex), RMA422, RMA42)
2 Commubox FXA191
3 RS232C
4 FieldCare
5 I/O card PLC/DCS passive
6 Field device (passive)
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 5 Operation of Commubox FXA191 in a control loop powered by a transmitter power supply. In the control
loop (loop-resistance ≥ 250 Ω)

1 Active power supply (RNS221, RN221N-A, RN221N-B (Ex), RMA422, RMA42)
2 Commubox FXA191
3 RS232C
4 FieldCare
5 I/O card PLC/DCS passive
6 Field device (passive)

4.2  Connection procedure
Normally, the Commubox FXA191 connects to the COM1 port when it is plugged into
the computer.

It is recommended that only a native serial port be used. The use of USB/Serial
converters is not recommended.

Deactivate the FIFO buffer in the serial port settings.

When working with a modem that is connected to the COM1 port of the computer, you
can also select the HART (Point-to-Point) item in the FieldCare dialog. This
automatically sets up the project and the program scans for a device with the HART
address 0 (standard for non-Multidrop mode).

Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the HART Communication item and click OK.
 The HART CommDTM is added to the network.

5. In the "Network" dialog, right-click HART Communication.
 A drop-down list opens.

6. Select Configuration.
 The "HART Communication (Configuration)" dialog opens.
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7. Define the parameters.
 Communication interface: HART modem

Serial interface: COM1 (communication port), the port can be selected from the
drop-down menu if the computer has a second RS232C port (COM2) and the
Commubox is connected to this port
HART protocol master: 5
HART protocol preamble: 3
HART protocol number of communication retries: 0
Address scan start address: 0
Address scan end address: 0 (highest station address for HART Multidrop)

8. Click OK.
 FieldCare returns to the "Network" dialog.

9. Right-click HART Communication.
 A drop-down list opens.

10. Select Create Network.
 FieldCare now scans the network and indicates the result.

The DeviceDTM is added to the network tree and the DTM opens.
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11. The DTMs are opened as follows if the Commubox FXA191 is connected to a HART
Multidrop network and several devices are found:
In the "Network" dialog, right-click the device and select Connect or Online
Parameterize.

12. Save the project →   13.

The project is saved.

If FieldCare cannot find the correct DTM, it will offer alternative versions, graded
according to their suitability in the "Scan Result" dialog. The user has the choice of
accepting a DTM of less quality, or canceling the scan.

If no new DTM is available, the user can still integrate the device by using the HART
iDTM.
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5  HART point-to-point connection via
Commubox FXA195

5.1  Use cases
The Commubox FXA195 provides a direct connection between a HART device
(4 to 20 mA) and the USB port of a computer. To establish communication with the HART
device, a resistor of at least 250 Ω must be provided in the circuit. The way in which this is
done depends upon the system architecture and power source used.

To see the HART device, FieldCare requires:
• HART CommDTM
• HART DeviceDTMs

Observe the maximum total load of the smart transmitter.

The communication resistor (250 Ω) integrated in the Commubox should not be
connected in parallel to a power supply point greater than 15 V. If the communication
resistor is used, it must always be incorporated into the 4 to 20 mA circuit.

LWARNING
A Commubox FXA195 from a non-Ex installation is used in an Ex installation.
Malfunction due overloaded protective circuits.
‣ A Commubox FXA195 from a non-Ex installation may not be used in an Ex installation.

For detailed information on "Commubox FXA195": Safety instructions →   11

5.1.1  Loop power from controller/field device

+

–

+

–

3 51 2 4

 6 Operation of a Commubox FXA195 in a control circuit (I/O card active/device passive or vice versa). In the
control circuit (communication resistor of FXA195 on)

1 I/O card PLC/DCS passive or active
2 Commubox FXA195
3 USB
4 FieldCare
5 Field device passive or active
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 7 Operation of a Commubox FXA195 in a control circuit (I/O card active/device passive or vice versa). Via a
resistor ≥ 250 Ω (recommended 270 to 330 Ω) in the control circuit (communication resistor of FXA195
off)

1 I/O card PLC/DCS passive or active
2 Commubox FXA195
3 USB
4 FieldCare
5 Field device passive or active
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+

–
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 8 Operation of a Commubox FXA195 in a control circuit (I/O card active/device passive or vice versa). In the
control circuit (loop-resistance ≥ 250 Ω)

1 I/O card PLC/DCS passive or active
2 Commubox FXA195
3 USB
4 FieldCare
5 Field device passive or active

5.1.2  Loop power from the transmitter power supply
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 9 Operation of Commubox FXA195 in a control loop powered by a transmitter power supply. From the
control room via the communication sockets of the transmitter power supply.

1 Active power supply (RNS221, RN221N-A, RN221N-B (Ex), RMA422, RMA42)
2 Commubox FXA195
3 USB
4 FieldCare
5 I/O card PLC/DCS passive
6 Field device (passive)
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 10 Operation of Commubox FXA195 in a control loop powered by a transmitter power supply. In the control
loop (communication resistor of FXA195 on)

1 Active power supply (RNS221, RN221N-A, RN221N-B (Ex), RMA422, RMA42)
2 Commubox FXA195
3 USB
4 FieldCare
5 I/O card PLC/DCS passive
6 Field device (passive)
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 11 Operation of Commubox FXA195 in a control loop powered by a transmitter power supply. Via a resistor ≥
250 Ω (recommended 270 to 330 Ω) in the control loop (communication resistor of FXA195 off)

1 Active power supply (RNS221, RN221N-A, RN221N-B (Ex), RMA422, RMA42)
2 Commubox FXA195
3 USB
4 FieldCare
5 I/O card PLC/DCS passive
6 Field device (passive)
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 12 Operation of Commubox FXA195 in a control loop powered by a transmitter power supply. In the control
loop (loop-resistance ≥ 250 Ω)

1 Active power supply (RNS221, RN221N-A, RN221N-B (Ex), RMA422, RMA42)
2 Commubox FXA195
3 USB
4 FieldCare
5 I/O card PLC/DCS passive
6 Field device (passive)



HART point-to-point connection via Commubox FXA195 Tutorial for FieldCare projects

24 Endress+Hauser

5.2  Installing the Commubox FXA195 driver
The computer automatically recognizes the Commubox FXA195. If this is not the
case, the driver must be installed as described in "Appendix A" →   178.

Installing the driver
1. Check the COM port:

Select Configuration → Control Panel → System.

2. Click Device Manager.

3. Open Ports (COM and LPT).
 The COM port is displayed and assigned to the Commubox.

5.3  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the HART Communication item and click OK.
 The HART CommDTM is added to the network.
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5. In the "Network" dialog, right-click HART Communication.
 A drop-down list opens.

6. Select Configuration.
 The "HART Communication (Configuration)" dialog opens.

7. Define the parameters.
 Communication interface: HART modem

Serial interface: COMx, the interface is in the drop-down menu
HART protocol master: Secondary Master
HART protocol preamble: 5
HART protocol number of communication retries: 3
Address scan start address: 0
Address scan end address: 0 (highest station address for HART Multidrop)

8. Click OK.
 FieldCare returns to the "Network" dialog.

9. Right-click HART Communication.
 A drop-down list opens.
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10. Select Create Network.
 FieldCare now scans the network and indicates the result.

The DeviceDTM is added to the network tree and the DTM opens.

11. The DTMs are opened as follows if the Commubox FXA195 is connected to a HART
Multidrop network and several devices are found:
In the "Network" dialog, right-click the device and select Connect or Online
Parameterize.

12. Save the project →   13.

The project is saved.

If FieldCare cannot find the correct DTM, it will offer alternative versions, graded
according to their suitability in the "Scan Result" dialog. The user has the choice of
accepting a DTM of less quality, or canceling the scan.

If no new DTM is available, the user can still integrate the device by using the HART
iDTM.
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6  HART via Fieldgate FXA520 and
Pepperl+Fuchs multiplexer

6.1  Use cases
To see the HART devices in the use cases detailed below, FieldCare requires:
• Fieldgate FXA520 CommDTM
• HART multiplexer master KFD2-HMM-16 (FDT) CommDTM
• HART DeviceDTMs

In addition, the computer must be assigned to a network address in same domain as
Fieldgate FXA520 before it can connect with its CommDTM.

Fieldgate FXA520 must be commissioned and assigned a network IP address before a
connection can be established.

For detailed information on "Fieldgate FXA520": Operating Instructions →   11

6.1.1  Parallel access to HART control loop with 4 to 20 mA
In this use case, the HART devices are connected to an analog I/O card (4 to 20 mA) of a
programmable logic controller. Normally, the devices will be powered by the card, but in
the case of 4-wire devices an external power supply will be required. Two-wire devices can
also be used in active mode, in which case external power sources will also be required.
The HART signal is accessed via a multiplexer and Fieldgate FXA520.
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Fieldgate
FXA520
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 13 Parallel access to HART control loops with 4 to 20 mA

1 FieldCare
2 Ethernet
3 Fieldgate FXA520
4 Pepperl+Fuchs HART multiplexer
5 Pepperl+Fuchs HART Termination Board
6 RS485
7 Controller with I/O cards

When the Pepperl+Fuchs KFD2-HMM-16 multiplexer is used it is possible to connect
30 devices to one Fieldgate FXA520. They can be arranged as 15 + 15 or as 16 + 14.

6.1.2  Direct/remote access to a HART monitoring system
This use case is a typical Fieldgate FXA520 inventory monitoring application where the
process values are acquired via a HART multiplexer. The same architecture can be used to
give FieldCare access to the devices for parameterization.
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Fieldgate
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 14 Direct/remote access to a HART monitoring system

1 FieldCare
2 Ethernet
3 Fieldgate FXA520
4 Pepperl+Fuchs HART multiplexer
5 Pepperl+Fuchs HART Termination Board
6 Power supply e.g. RN211N-B or RNS211
7 RS485

In this case, the devices must be powered, e.g. by a RNS221 or RN211N-B power unit
for non-hazardous and hazardous areas respectively. Each power supply can power
two devices. A maximum of 30 devices can be connected to one Fieldgate FXA520.

6.2  Connection procedure
The following example shows how the Fieldgate FXA520 can be commissioned with
FieldCare. It is assumed that the FXA520 DTM is already installed.

6.2.1  Connecting and configuring Fieldgate FXA520

Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.



HART via Fieldgate FXA520 and Pepperl+Fuchs multiplexer Tutorial for FieldCare projects

30 Endress+Hauser

3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the FXA520 item and click OK.
 The FXA520 is added to the network.

5. In the "Network" dialog, right-click FXA520.
 A drop-down list opens.
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6. Select Configuration.
 The "FXA520 (Configuration)" dialog opens.

7. Enter the following parameters, and press Enter to confirm each entry.
 If the user name and password of the FXA520 (default: super/super) have been

changed, the values must be entered in the appropriate fields.
Access Mode: Fieldgate direct
Connection Type: LAN → Fieldgate
Communication Mode: Direct (pass-through-HART)
Remote IP Address: IP address of the Fieldgate (default: 192.168.252.1)

8. Close the "FXA520 (Configuration)" dialog by clicking X in the top right-hand corner.

9. In the "Network" dialog, right-click FXA520.
 A drop-down list opens.

10. Select Create Network.
 The "Select Communication Channel" dialog opens.

11. Select the RS485CH option.

12. Click OK.
 The scan is started.
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13. Click OK.
 The multiplexer DTM is added to the network.

FieldCare is connected and configured.

If only one multiplexer is found, its DTM is added to the network. If there are two
multiplexers or if the DTM quality does not equal "1", the "Scanning Result" dialog
opens automatically.

6.2.2  Commissioning the Pepperl+Fuchs multiplexer
When the multiplexer is added to the network, the "Configuration" dialog of the
multiplexer opens automatically. If this is not the case or if two multiplexers are
connected to Fieldgate FXA520, you must invoke the "Configuration" dialog manually.

Commissioning the multiplexer
1. Right-click the KFD2-HMM-16 (FDT) item and select Configuration.

 The "Configuration" dialog opens.

2. Enter all the necessary information, e.g. the tag and description.

3. Click the X in the top right-hand corner.
 The multiplexer DTM closes.

4. In the "Network" dialog, right-click Multiplexer.
 A drop-down list opens.

5. Select Add Device.
 The "Add New Device" dialog opens.

6. Select the KFD2-HMM-16 (FDT) item and click OK.
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The multiplexer is added to the network.

Although from the hardware point of view only one unit exists, at least two DTMs are
required for the multiplexer head station. These comprise a master KFD2-HMM-16
(Master) and a slave KFD0-HMS-16 (Slave00). Additional slaves must be added
according to the number of multiplexer channels in use.

Assigning device to channel
1. In the "Assign Device to Channel" dialog, select the Slave00 item.



2. Click OK.
 The slave is added to the "Network" dialog.

If a second master or additional slave is present, repeat Steps 1 and 2 to add it to the
Network View.

Fieldgate FXA520 can handle a maximum of 30 devices with its Web server. For
FieldCare the number is higher, but the FXA520 cannot be used to display the
measured values.

Creating a network
1. In the "Network" dialog, right-click a Slave.

 A drop-down list opens.
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2. Select Create Network.
 The "Select Communication Channel" dialog opens.

3. Click OK.
 All the connected devices are scanned.

The project looks something like this:

4. In the "Network" dialog, right-click a device.
 A drop-down list opens.

5. Select Online Parameterize.
 The DeviceDTM opens. If the DeviceDTM is not connected, first select Connect.

The device can now be configured in accordance with the Operating Instructions.

6. Save the project →   13.
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7  HART via Pepperl+Fuchs LB/FB Remote I/O

7.1  Use case
This chapter describes how FieldCare should be configured for a plant that uses a Pepperl
+Fuchs LB/FB Remote IO. The PC with FieldCare installed is connected to a PLC (e.g. a
Melsec Q12 from Mitsubishi) via Ethernet. The PLC connected with the Remote IO via
PROFIBUS DP; Remote I/O is connected to several HART field devices.

The following software packages must be installed and configured on the PC:
• Mitsubishi CommDTM: Download at http://www.mitsubishielectric.com →

MXCommDTMPBDPsetup.exe
• CommDTM Remote IO: Download at http://www.pepperl-fuchs.com →

DTM_RemoteIO_LB_FB-setup-Vx.exe

1

2

3

4

5

 15 Access via Pepperl+Fuchs LB/FB Remote I/O

7.2  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the MXCommDTM-PBDP item and click OK.
 MXCommDTM-PBDP is added to the network.

A different device-specific CommDTM must be used for other PLCs.

5. In the "Network" dialog, right-click MXCommDTM-PBDP.
 A drop-down list opens.

6. Select Add Device.
 The "Add New Device" dialog opens.

7. Select the LB 8109 LB-DPV1 UNICOM Interface item and click OK.
 LB 8109 LB-DPV1 UNICOM Interface is added to the network.
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8. In the "LB 8109 LB-DPV1 UNICOM Interface" dialog, right-click LB 8109 LB-DPV1
UNICOM Interface.
 A drop-down list opens.

9. Select Create Network.
 A dialog opens.

10. Select communication channels and slots that must be scanned.
 Cards are scanned.

11. Under Create Network - Scan Result, select SLOT 03 and click Assign Device Type
(DTM).
 The "Assign Device Type (DTM)" dialog opens.

12. Tick the box Show All Installed Device Types of this Protocol.
 All the device types installed for this protocol are displayed.
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13. Select the device DTM LB3106 HART Transmitter Power Supply and click OK.
 The LB 3106 HART transmitter power supply is assigned to SLOT 03.

Repeat the previous step for all the DeviceDTMs found and press OK to confirm.

FieldCare can be used once all the DeviceDTMs have been assigned.

The Pepperl+Fuchs FB/LB can be used with a Fieldgate SFG500 in the same way.
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8  HART via RS232 to RS485 converter and
Pepperl+Fuchs multiplexer

8.1  Use cases
To see the HART devices in the use cases detailed below, FieldCare requires:
• RS232 to RS485 to converter (e.g. ExpertDAQ EX9520)
• HART multiplexer master KFD2-HMM-16 (FDT) CommDTM
• HART DeviceDTMs

8.1.1  Direct/remote access to a HART monitoring system
This use case is a typical application where the process values are acquired via a HART
multiplexer (MUX). The same architecture can be used to give FieldCare access to the
devices for parameterization.

Fieldgate
FXA520

ENDRESS+HAUSER
RNS221

CH1

CH2

ON 1 2

1 2

3

5 4

7

6

 16 Direct/remote access to a HART monitoring system

1 FieldCare
2 RS232
3 RS232 to RS485 converter e.g. ExpertDAQ EX9520
4 Pepperl+Fuchs HART multiplexer (KFD2-HMM-16)
5 Pepperl+Fuchs HART termination board (FI-PFH-110469)
6 Power supply e.g. RN211N-B or RNS211
7 RS485

In this case, the devices must be powered, e.g. by a RNS221 or RN211N-B power unit
for non-hazardous and hazardous areas respectively.
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8.2  Connection procedure
The following example shows how the multiplexer can be commissioned with FieldCare.
As a prerequisite, the HART Comm DTM must be installed and the PC must have a serial
interface to COM1. In addition, the Pepperl+Fuchs drivers must be installed: DTM
Collection HART Multiplexer/DTM Collection HART Multiplexer on the Pepperl+Fuchs
homepage www.pepperl-fuchs.com.

8.2.1  Connecting and configuring Fieldgate SFG500

Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the HART Communication item and click OK.
 The HART Communication DTM is added to the network.

5. In the "Network" dialog, right-click HART Communication.
 A drop-down list opens.
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6. Select Configuration.
 The "HART Communication (Configuration)" dialog opens.

7. Define the parameters.
 Communication Interface: HART multiplexer

Serial Interface: COM1
Baud Rate: 9600
RTS Control: Disable
HART Protocol: Primary Master
Preamble and Number of Communication Retries: leave default setting
Address Scan: Start and end address set to 1

8. In the "Network" dialog, right-click the HART Communication item.
 A drop-down list opens.

9. Select Create Network.
 Scanning is performed.

If the message "Automatic DTM identification of one or more devices failed…"
appears, click OK to confirm.
The KFD2-HMM-16(FDT) item is added to the network.

10. In the "Network" dialog, right-click the KFD2-HMM-16(FDT) item.
 A drop-down list opens.

11. Select Add New Devices.
 The "Add New Device" dialog opens.
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12. Select the KFD0-HMS-16 item and click OK.
 The "Assign Device to Channel" dialog opens.

13. Select Slav00 as the channel because the KFD2-HMM-16 is the master and slave and
the slave automatically and unalterably has 0 as its address.
 The KFD0-HMS-16 is added to the network.

14. In the "Network" dialog, right-click the KFD0-HMS-16 item.
 The "Select Communication Channel" dialog opens.

The channels correspond to the ports on the "KFD0-HMS-16" termination board.

15. Typically select all the channels to which HART devices are connected and press OK
to confirm.
 The scan starts.

All the connected devices are displayed and can be changed.

A successful connection is not possible via USB serial converter and RS232/RS485
interface converter.
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9  HART via Rockwell Automation ControlLogix

9.1  Use case
The PlantPAx is a system to which different Rockwell Automation modules can be
appended. The following range of I/O modules can be used:
• HART I/O 1756sc-IF8H, 1756sc-IF16H, 1756sc-OF8H
• FLEX I/O 1794sc-IF8IH
• POINT I/O 1734sc-IE4CH, 1734sc-IE2CH, 1734sc-OE2CIH
• COMPACT I/O 1769sc-IF4IH, 1769sc-IF20H

To see the HART devices in the use cases detailed below, FieldCare requires:
• HART CommDTM
• HART DeviceDTMs
• RSLinx Classic

11

3

4

5

6

2

 17 Access via ControlLogix to a HART network

1 FieldCare
2 Ethernet
3 ControlLogix HART I/O
4 Flex I/O
5 Point I/O
6 Compact I/O

9.2  Connection procedure
The DTM catalog must be updated before you can start connecting.

For detailed information on "Updating the DTM catalog": Getting Started →   11

Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the RSLinx 1756 Backplane item and click OK.
 The RSLinx 1756 Backplane is added to the network.

5. In the "Network" dialog, double-click RSLinx 1756 Backplane in the Device Type
(DTM) column.
 The "RSLinx 1756 Backplane (Configuration)" dialog opens.

6. Click Select Path.
 The "Select 1756-Backplane" dialog opens.

7. Open the AB-ETHIP-1, Ethernet item. (This name can be selected individually!)

8. Select a device and click OK.
 The device is added to the network.

9. Enter the slot number and press Enter to confirm.
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10. In the "Network" dialog, right-click the RSLinx 1756 Backplane item.
 A drop-down list opens.

11. Select Create Network.
 FieldCare scans the network and indicates the result. The DeviceDTM is added to

the network.

Save the project →   13.

If no DeviceDTM is installed, FieldCare states that proper communication can only be
ensured after the DTM has been installed.

There is no possibility to connect to the device if the matching DTM is not installed:
– Right-click Device and select Connect
– Right-click Device and select Online Parameterize

9.3  Access to device data
Device access
1. In the "Network" dialog, right-click a device.

 A drop-down list opens.

2. Select Connect.
 The DeviceDTM is connected and all the arrows appear green.

3. In the "Network" dialog, double-click the connected device in the Device Type (DTM)
column.
 The device data are displayed.

4. In the "Network" dialog, right-click a device.
 A drop-down list opens.

5. Click Observe.
 The measured values are displayed.

FieldCare offers additional functions, such as:
• Switching device mode to connected or not connected
• Reading data from the device
• Writing data to the device
• Device-specific functions
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10  HART via RSG45

10.1  Use case

1 2 3 4

 18 Connection with RSG45 HART communication

1 FieldCare
2 Ethernet
3 Memograph M RSG45
4 Slot

To see all the devices on the HART segment, FieldCare requires:
• RSG45 HART CommDTM
• HART DeviceDTMs

10.2  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.
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4. Select the RSG45 HART Communication item and click OK.
 RSG45 HART Communication is added to the network.

5. In the "Network" dialog, right-click RSG45 HART Communication.
 A drop-down list opens.

6. Select Configuration.
 The "RSG45 HART Communication (Configuration)" dialog opens.

7. On the "Configuration" tab, enter the RSG45 IP address, the RSG45 port and the
address range for scanning the Memograph M RSG45, and then click Apply.

8. In the "Network" dialog, right-click RSG45 HART Communication.
 A drop-down list opens.
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9. Select Create Network.
 The "Select Communication Channel" dialog opens.

10. Select the channels to be scanned and click OK.
 FieldCare scans the selected channels and adds the devices found to the network.

11. In the "Network" dialog, right-click a device.
 A drop-down list opens.

12. Select Connect.
 The arrows next to the device appear green.
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13. In the Network dialog, right-click a device.
 A drop-down list opens.

14. Select Online Parameterize.
 The DeviceDTM opens.

The device can now be configured in accordance with the Operating Instructions.

15. Save the project →   13.
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11  HART Multidrop or HART point-to-point
connection via Fieldgate FXA520

11.1  Use cases
To see the HART devices in the use cases detailed below, FieldCare requires:
• HART CommDTM
• HART DeviceDTMs

Fieldgate FXA520 must be commissioned and assigned a network IP address before
you can start connecting.

The computer must be assigned to a network address in same domain as Fieldgate
FXA520 before it can connect with its CommDTM.

For detailed information on "Fieldgate FXA520": Operating Instructions →   11

For detailed information on "Setting up the IP address": Operating Instructions
→   11

11.1.1  HART Multidrop
This use case is a typical Fieldgate FXA520 inventory monitoring application where the
process values are acquired via a HART Multidrop bus. The same architecture can be used
to give FieldCare access to the devices for parameterization.

Fieldgate
FXA520

ENDRESS+HAUSER
RNS221

CH1

CH2

ON 1 2

1 2

3

45

6

 19 HART Multidrop via Fieldgate FXA520

1 FieldCare
2 Ethernet
3 Fieldgate FXA520 Multidrop power supply
4 Channel 0 with maximum 8 devices
5 Channel 1 with maximum 8 devices
6 Fieldgate FXA520

11.1.2  HART point-to-point connection
The two HART channels (4 to 20 mA) of the Fieldgate FXA520 can also be used to make
point-to-point connections to individual HART devices.
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Fieldgate
FXA520

ENDRESS+HAUSER
RNS221

CH1

CH2

ON 1 2

1 2

36

45

 20 HART point-to-point connection via Fieldgate FXA520

1 FieldCare
2 Ethernet
3 HART power supply
4 Channel 0
5 Channel 1
6 Fieldgate FXA520

11.2  Connection procedure
To establish the connection, the FXA520 DTM must be installed.

Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the FXA520 item and click OK.
 The FXA520 is added to the network.

5. In the "Network" dialog, right-click FXA520.
 A drop-down list opens.
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6. Select Configuration.
 The "FXA520 (Configuration)" dialog opens.

7. Enter the following parameters in the "FXA520 (Configuration)" dialog and confirm
each entry.
 If the FieldCare user name and password have been changed, the values must be

entered in the appropriate fields.
Access Mode: Fieldgate direct
Connection Type: LAN → Fieldgate
Communication Mode: Direct (pass-through-HART)
Remote IP Address: IP address of the Fieldgate (default: 192.168.252.1)

8. Close the "FXA520 (Configuration)" dialog by clicking X in the top right-hand corner.

9. In the "Network" dialog, right-click FXA520.
 A drop-down list opens.

10. Select Create Network.
 The "Select Communication Channel" dialog opens.
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11. Select the HARTCH0 and/or HARTCH1 option (select both in this case) and click OK.
 The scan is started. The devices found are assigned to their DTMs and added to

the project.

12. In the "Network" dialog, right-click a device.
 A drop-down list opens.

13. Select Connect.
 The connection to the DeviceDTM is established.

14. In the "Network" dialog, right-click a device.
 A drop-down list opens.

15. Select Online Parameterize.
 The DeviceDTM opens.

16. Save the project →   13.
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12  HART point-to-point or HART Multidrop via
MACTek Bluetooth modem

12.1  Use cases
To see the HART device, FieldCare requires:
• HART CommDTM
• HART DeviceDTMs

• Bluetooth must be enabled on the computer.
• The Bluetooth modem must be installed on the computer and the Bluetooth

connection set up →   178.

12.1.1  Point-to-point connection
In a point-to-point connection, the MACTek modem is connected in parallel to the
measuring device or in parallel to the communication resistor.

+

–

+

–

+

–

+

–

3 51 2 43

3 51 2 43

 21 Operation of a MACTek modem in a control loop (I/O card active/device passive or vice versa)

1 I/O card PLC/DCS active or passive
2 MACTek modem
3 Bluetooth
4 FieldCare
5 Field device passive or active

12.1.2  Multidrop connection
In a Multidrop connection, the MACTek modem is connected to the bus line.
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+

–

31 2 43

5 5 5

 22 Operation of a MACTek modem with the HART Multidrop bus

1 I/O card PLC/DCS active or passive
2 MACTek modem
3 Bluetooth
4 FieldCare
5 Passive field device (0-15 devices)

12.2  Connection procedure
1. Switch on the MACTek modem.

2. In the "Bluetooth Settings" dialog, select Bluetooth → New Connect.


Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the HART Communication item and click OK.
 The HART Communication DTM is added to the network.

5. In the "Network" dialog, right-click HART Communication.
 A drop-down list opens.



HART point-to-point or HART Multidrop via MACTek Bluetooth modem Tutorial for FieldCare projects

58 Endress+Hauser

6. Select Configuration.
 The "COM40 (Configuration)" dialog opens.

7. Define the parameters.
 Communication interface: HART modem

Serial interface: COMx, the interface is in the drop-down menu
HART protocol master: 5
HART protocol preamble: 3
HART protocol number of communication retries: 0
Address scan start address: 0
Address scan end address: 0 (highest station address for HART Multidrop)

8. Click OK.
 FieldCare returns to the "Network" dialog.

9. Right-click HART Communication.
 A drop-down list opens.

10. Select Create Network.
 FieldCare now scans the network and indicates the result.

The DeviceDTM is added to the network tree and the DTM opens.
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11. The DTMs are opened as follows if the Commubox FXA195 is connected to a HART
Multidrop network and several devices are found:
In the "Network" dialog, right-click the device and select Connect or Online
Parameterize.

Save the project →   13.

If FieldCare cannot find the correct DTM, it will offer alternative versions, graded
according to their suitability in the "Scan Result" dialog. The user has the choice of
accepting a DTM of less quality, or canceling the scan.

If no new DTM is available, the user can still integrate the device by using the HART
iDTM.
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13  HART via SFG250 Ethernet gateway

13.1  Use case

1 2 3 4

 23 Connection with SFG250 HART Ethernet gateway

1 FieldCare
2 Ethernet
3 RNS221
4 HART SFG250 Ethernet gateway

Before a connection can be established between FieldCare and the device it is
necessary to check whether the gateway is accessible in the network.

13.2  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.
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4. Select the isNet Lite item and click OK.
 IsNet Lite is added to the network.

5. In the "Network" dialog, right-click isNet Lite.
 A drop-down list opens.

6. Select Configuration.
 The "isNet Lite (Configuration)" dialog opens.

7.

Enter the IP address, select channel and click OK.

8. In the "Add New Device" dialog, select the isNet H@rt(8 channels) item and click OK.
 IsNet H@rt(8 channels) is added to the network.

9. In the "Network" dialog, right-click isNet H@rt(8 channels).
 A drop-down list opens.
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10. Select Offline Parameterize.
 The "isNet H@rt(8 channels) (Offline Parameterize)" dialog opens.

11. In the "Network" dialog, right-click a device.
 A drop-down list opens.

12. Select Online Parameterize.
 The configuration can now be made.



Tutorial for FieldCare projects HART via HIMA multiplexer HIMAX

Endress+Hauser 63

14  HART via HIMA multiplexer HIMAX

14.1  Use case
A PC with FieldCare is connected via Ethernet to a HIMA multiplexer HIMAX to which
several HART devices are connected.

1 2 3

 24 Connection with HIMAX HART multiplexer

1 FieldCare
2 Ethernet
3 HIMA multiplexer HIMAX

To see all the devices on the HART segment, FieldCare requires three DTMs:
• HIMA HART IP CommDTM
• HIMA X ComDTM
• HIMA HART DeviceDTM

In addition, two setups must be downloaded from the HIMA website (www.hima.com) and
executed:
• HIMAX_DTM_SETUP_1_0_0_1
• EMUXCommDTM_HIMA_Setup_1_1_0_6

14.2  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the HART IP Communication item and click OK.
 HART IP Communication is added to the network.

5. In the "Network" dialog, right-click HART IP Communication.
 A drop-down list opens.

6. Select Other Functions → DTM Addresses.
 The "HART IP Communication" configuration window opens.

7. The IP address of the multiplexer must be configured in the "UDP Address" field.

8. In the "Network" dialog, right-click HART IP Communication.
 A drop-down list opens.

9. Select Add Device.
 The "Add New Device" dialog opens.

10. Select the X-COM-DTM item and click OK.
 X-COM-DTM is added to the network.

11. In the "Network" dialog, right-click X-COM-DTM.
 A drop-down list opens.

12. Select Connect.
 The connection is established.
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13. In the "Network" dialog, right-click Additional Functions → HART Modules.
 The available modules are added under the X-COM-DTM (X-HART-DTM items).

14. In the "Network" dialog, right-click X-HART-DTM.
 A drop-down list opens.

15. Select Add Device.
 The "Add New Device" dialog opens.

16. Select the Create Network item and click OK.

A dialog appears in which all the available HART channels are displayed.

In this dialog it is possible to disable HART channels that are not used and are
excluded from subsequent scanning in order to speed up the process. After scanning,
all the HART devices found are displayed in the network view and can be configured.
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15  WirelessHART Adapter SWA70 via HART
modem

15.1  Use case
With regard to operation with FieldCare, the WirelessHART Adapter SWA70 acts like all
other HART devices. The connection can be established with a standard HART modem e.g.
Commubox FXA191, Commubox FXA195 or MACTek.

2 21 3 4

1 6 5 4

 25 Connection of a HART modem with the WirelessHART Adapter SWA70

1 FieldCare
2 Bluetooth
3 MACTek modem
4 WirelessHART Adapter terminals 7 and 8
5 HART Modem
6 USB or RS232

The HART modem can be connected either to terminals 5 and 6 or to terminals 7
and 8 of the WirelessHART Adapter.

For communication via a MACTek modem, a 250 Ω communication resistor must be
used.

A 250 Ω communication resistor must be used or switched on for communication via
Commubox FXA195.

If the WirelessHART Adapter is operated in a control loop with a communication
resistor no additional resistor is needed.

The COM port number is assigned when installing the Commubox FXA195 or
MACTek modem. This number is required later on.

To establish the connection via FieldCare, the COM port must be configured for the
selected HART modem. The HART CommDTM and the SWA70 DTM are needed for
the SWA70.

15.2  Connection procedure
Check whether the WirelessHART Adapter is connected to a power supply unit and is
in the communication mode.

For detailed information on the "WirelessHART Adapter SWA70": Operating
Instructions →   11



Tutorial for FieldCare projects WirelessHART Adapter SWA70 via HART modem

Endress+Hauser 67

Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the HART Communication item and click OK.
 HART Communication DTM is added to the network.

5. In the "Network" dialog, right-click HART Communication.
 A drop-down list opens.
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6. Select Configuration.
 The "HART Communication (Configuration)" dialog opens.

7. Enter the following parameters, and press Enter to confirm each entry.
 Communication interface: HART modem

Serial port: e.g. COMx (port the modem is connected to)
HART protocol master: Secondary Master
HART protocol preamble: 5
HART protocol number of communication retries: 7
Address scan start address: 14 since scanning is quicker
Address scan start address: 15 since this is the default address of the
WirelessHART Adapter

8. Click OK.

9. In the "Network" dialog, right-click COM8.
 A drop-down list opens.

10. Select Create Network.
 The WirelessHART Adapter is added to the network and the WirelessHART

Adapter DTM opens.

11. Save the project →   13.

For detailed information on "Configuring the WirelessHART Adapter SWA70":
Operating Instructions →   11
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16  WirelessHART Fieldgate SWG70 via Ethernet

16.1  Use case
The WirelessHART Fieldgate SWG70 is configured via its Ethernet interface.

1 2 3

 26 Connection with the WirelessHART Fieldgate SWG70 via Ethernet

1 FieldCare with address 192.168.1.xxx
2 Ethernet
3 Fieldgate SWG70 with address 192.168.1.1

Fieldgate SWG70 is supplied with the default address of 192.168.1.1. This matches the
default address of the HART IP CommDTM.

The computer and the SWG70 must be in the same address domain (IP address, subnet
mask). This must be taken into consideration if the address of the computer or SWG70 is
changed.

To see the Fieldgate SWG70, FieldCare requires:
• HART IP CommDTM
• SWG70 DTM

The HART IP CommDTM and the SWG70-DTM are needed to connect via FieldCare.

16.2  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the HART IP Communication item and click OK.
 HART IP Communication is added to the network.

5. In the "Network" dialog, right-click HART IP Communication.
 A drop-down list opens.

6. Select Add Device.
 The "Add New Device" dialog opens.

7. Select WirelessHART Fieldgate and click OK.
 FieldCare automatically recognizes and selects the right DTM and the "Add New

Device" dialog closes.
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8. If the configured IP address (192.168.1.1) or the Ethernet port (5094) of the
Fieldgate SWG70 has been changed or a new Fieldgate address must be entered,
proceed as follows:
In the "Network" dialog, right-click HART IP Communication.
 A drop-down list opens.

9. Select Other Functions → Set DTM Addresses.
 The "HART IP Communication (Set DTM Addresses)" dialog opens.

10. Enter the new IP address and/or Ethernet UDP port number.

11. Click Update Changed Data.

12. Close the "HART IP Communication (Set DTM Addresses)" dialog.

13. Right-click the WirelessHARTFieldgate item in the "Network" dialog.
 A drop-down list opens.

14. Select Connect.
 The HART IP CommDTM and WirelessHART Fieldgate are connected and all the

arrows appear green.

15. In the "Network" dialog, click WirelessHART Fieldgate.
 A drop-down list opens.
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16. Select Online Parameterize.
 The "WirelessHART Fieldgate (Online Parameterize)" dialog opens.

17. Expand all the submenus of the directory tree to reveal the parameter blocks.

The device can now be configured in accordance with the Operating Instructions.

The WirelessHART Fieldgate DTM can also be used to scan for WirelessHART
Adapters and devices in the network.

For detailed information on "WirelessHART Fieldgate SWG70": Operating Instructions
→   11



Tutorial for FieldCare projects Modbus via RS485 Modbus

Endress+Hauser 73

17  Modbus via RS485 Modbus

17.1  Use case

1 2 3

 27 Connection with Modbus via RS485 Modbus

1 FieldCare
2 RS485 Modbus
3 Field device

To see all the devices on the Modbus segment, FieldCare requires:
• Modbus DTM
• Modbus DeviceDTMs

17.2  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.
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1. Select the Modbus Serial Communication DTM item and click OK.
 The Modbus Serial Communication DTM is added to the network.

2. In the "Network" dialog, right-click Modbus Serial Communication DTM.
 A drop-down list opens.

3. Select Configuration.
 The "Modbus Serial Communication DTM (Configuration)" dialog opens.

4. On the "Configuration" tab, select COM3 for the COM port.

5. Select the "Request" tab.

6. For the request mode, select Single-point, enter the address 247 and click Apply.
 The changes are accepted and saved.

7. In the "Network" dialog, right-click Modbus Serial Communication DTM.
 A drop-down list opens.

8. Select Create Network.
 FieldCare scans the network and indicates the result. The

MODBUS_SERIALCommChannel is added to the network.
The "Online Parameterize" dialog opens and the device can be parameterized.
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18  EtherNet/IP via Ethernet

18.1  Use case

1 2 3

 28 Connection with EtherNet/IP via Ethernet

1 FieldCare
2 Ethernet
3 Field device

To see all the devices on the Ethernet segment, FieldCare requires:
• EtherNet/IP CommDTM
• EtherNet/IP DeviceDTMs

18.2  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.
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4. Select the EtherNet/IP Comm Adapter item and click OK.
 EtherNet/IP Comm Adapter is added to the network.

5. In the "Network" dialog, right-click EtherNet/IP Comm Adapter.
 A drop-down list opens.

6. Select Configuration.
 The "EtherNet/IP Comm Adapter (Configuration)" dialog opens.

7. On the "Configuration" tab, enter the IP address of the PC under host address.

8. Select the "Request" tab.

9. For the request mode, select Multi-point, enter the IP address start address and
click Apply.
 The changes are accepted and saved.

10. In the "Network" dialog, right-click EtherNet/IP Comm Adapter.
 A drop-down list opens.

11. Select Create Network.
 FieldCare scans the network and indicates the result. The device is added to the

network.
The "Online Parameterize" dialog is displayed and the device can be
parameterized.
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19  PROFINET - PROFIBUS PA Softing Gateway

19.1  Use case
The Softing PROFINET – PROFIBUS PA Gateway pnGATE PA allows a PROFINET network
to connect to a PROFIBUS PA segment. A PC with FieldCare is connected to the PROFINET
network via a switch.

To see all the devices on the PROFIBUS PA segment, FieldCare requires:
• PROFIBUS DeviceDTMs
• PROFIdtm DPV1 CommDTM
• PROFIBUS driver PROFIboard

31 2

4

5

6

 29 Connecting FieldCare with a PROFINET - PROFIBUS PA Gateway

1 FieldCare
2 Ethernet
3 Gateway
4 PROFINET
5 Gateway pnGATE PA
6 PROFIBUS PA

19.2  Setting up the gateway
Before a connection is established with FieldCare, it is necessary to configure the
PROFIBUS Control Panel for the pnGATE and the IP address.

For detailed information in this regard, see the User Manual for pnGate PA.
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19.3  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the PROFIdtm DPV1 item and click OK.
 The PROFIdtm DPV1 is added to the network.

5. The "Node Name" (default: Node0) entered previously in the PROFIBUS Control Panel
must be selected in the "Board Name" field. The other parameters must be checked
and modified as they can vary depending on the plant. The parameters in the Group
Runtime Performance are supplied by the PLC and cannot be modified.

6. In the "Network" dialog, right-click the PROFIdtm DPV1 item.
 A drop-down list opens.
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7. Select Create Network.
 FieldCare now scans the network and adds all devices found to the network.

8. Save the project →   13.
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20  PROFIBUS PA via Rockwell Automation
ControlLogix

20.1  Use case
The PlantPAx architecture provides a manufacturer and user technology such that the
input data and the output condition can be used by all ControlLogix controllers in the
system.

11

3

4

5

2

 30 ControlLogix access to a PROFIBUS PA network

1 FieldCare
2 Ethernet
3 ControlLogix
4 1788HP-EN2PAR
5 PROFIBUS PA

To see the PROFIBUS PA devices, FieldCare requires:
• HS EtherNet/IP DTM
• 1788-EN2PAR DTM
• PROFIBUS DeviceDTMs

20.2  Connection procedure
The FieldCare catalog must be updated before you can start connecting.

For detailed information on "Updating the DTM catalog": Getting Started →   11

Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the HS EtherNet/IP item and click OK.
 The HS EtherNet/IP is added to the network.

5. In the "Network" dialog, right-click HS EtherNet/IP.
 A drop-down list opens.

6. Select Add Device.
 The "Add New Device" dialog opens.

7. Select the 1788-EN2PAR item and click OK.
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8. In the "Network" dialog, double-click 1788-EN2PAR in the "Device Type (DTM)"
column.
 The "1788-EN2PAR (Configuration)" dialog opens.

9. Enter the Module IP Address and the Max Scan Address and press Enter to
confirm.

10. In the "Network" dialog, right-click the 1788-EN2PAR item.
 A drop-down list opens.

11. Select Create Network.
 FieldCare scans the network and indicates the result. The 1788-EN2PAR-DTM is

added to the network.

12. In the "Network" dialog, right-click the 1788-EN2PAR item.
 A drop-down list opens.

13. Select Connect.
 All the arrows appear green.

14. In the "Network" dialog, right-click the 1788-EN2PAR item.
 A drop-down list opens.

15. Select Online Parameterize.
 The "1788-EN2PAR (Online Parameterize)" dialog opens.

16. Save the project →   13.

The project is saved.

If no DeviceDTM is installed, FieldCare states that proper communication can only be
ensured after the DTM has been installed.

There is no possibility to connect to the device automatically if the matching DTM is
not installed.

Manually connecting to the device:
– Right-click Device and select Connect
– Right-click Device and select Online Parameterize
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21  PROFIBUS DP/PA via Fieldgate FXA720

21.1  Use case
This use case is typical for the use of Fieldgate FXA720 to provide parallel access to a
PROFIBUS control system, e.g. for device set-up, device diagnosis or condition monitoring.
Fieldgate FXA720 operates as a Master Class 2 and uses non-cyclic communication.

A similar architecture, but not necessarily with a controller, could be used for the
monitoring of tank inventory in connection with SupplyCare software. In this case
FieldCare is used for set-up and diagnosis only.

To see the PROFIBUS DP/PA devices, FieldCare requires:
• PROFIdtm DPV1 CommDTM
• PROFIBUS CommDTM
• PROFIBUS DeviceDTMs

A transparent coupler is one that does not require a CommDTM to connect to the
PROFIBUS PA devices beneath it. Pepperl+Fuchs DP/PA couplers are examples. If a
Siemens coupler or link is used, a CommDTM is required for it. The procedure for
connecting is analogous to that described in this chapter, the link being found during the
creation of the network after the Fieldgate FXA720 CommDTM has been added to the
FieldCare host.
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 31 Fieldgate FXA720 access to a PROFIBUS DP/PA network

1 FieldCare
2 Ethernet
3 Fieldgate FXA720
4 PROFIBUS DP
5 PROFIBUS PA
6 Transparent DP/PA coupler
7 Controller with I/O cards
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21.2  Commissioning the Fieldgate FXA720

21.2.1  Basic configuration
Before this procedure can be started, the IP address that Fieldgate is allocated within
the control network must be known.

If the Web browser does not find the Web server, it is essential to check whether a
proxy is in use and to switch it off if necessary.

Commissioning the Fieldgate FXA720
Set the IP address of the computer to the same domain as the Fieldgate FXA720's default
address 192.168.253.1.

1. Start the Web browser.


2. Enter the Fieldgate FXA720's default address "192.168.253.1" into the address field
of the browser and press Enter to confirm.
 The browser makes a connection with the Fieldgate FXA720 and the "Login"

dialog opens.

3. Enter superb as the password and click Login.
 The Fieldgate FXA720 Web server opens. (Devices are not necessarily visible at

this point).

4. Click Switch to Specialist Mode.
 The "Login" dialog opens.

5. Enter admin as the user name and super as the password and click Login.

6. Click Information & Configuration → PROFIBUS Setup.

7. Scroll down to the "Scan 1" dialog.
 The "Scan 1" dialog opens.
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8. Set "Scan Cycle Time" to off.
 This disables the PROFIBUS scan.

9. Click Send.
 Changes are downloaded to the Fieldgate FXA720.

10. Click Information & Configuration → Network Setup.

11. Scroll down to the "Ethernet" dialog.
 The "Ethernet" dialog opens.

12. Enter the IP address and Subnet Mask.

13. Click Send.
 Parameters are downloaded to the Fieldgate FXA720.

14. Close the Web browser and reset the IP address of the computer to one in the same
domain as the new Fieldgate FXA720 IP address.

15. Enter the new IP address in the Web browser once more to check the connection to
Fieldgate FXA720.

16. Close the Web browser.

21.2.2  Connection procedure
The Fieldgate FXA720 must be commissioned before it can be used. This is done by
either running the set-up program supplied on the accompanying DVD or calling the
PROFIBUS Control Panel Applet from the PROFIBUS DPV1 CommDTM.

For detailed information on "Fieldgate FXA720": Operating Instructions →   11

Starting the PROFIBUS Control Panel
1. Start the PROFIBUS Control Panel Applet.

2. In the "Network" dialog, right-click PROFIBUS DPV1 CommDTM.
 A drop-down list opens.
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3. Select Other Functions → PROFIBUS Control Panel Applet.
 The "PROFIBUS Control Panel" dialog opens.

For this to happen, the PROFIBUS DVP1 CommDTM must have been added to the
HOST PC beforehand.

PROFIBUS set-up
1. In the "PROFIBUS Control Panel" dialog, select the FG series/PROFIgate item and

click Add.
 The "Select Node Name" dialog opens.

2. Enter a symbolic node name for the PROFIBUS DP channel (default value: Node 0)
and click Next.
 The "Select Addresses for FG series / PROFIgate" dialog opens.
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3. Enter the IP address of the Fieldgate, select Bus Connector and click Next.
 The "Select Timeouts for FG series / PROFIgate" dialog opens and the user can

make the standard timeout setting.

4. Enter the "Timeout for Connect" and click Finish. These settings may be made by
PROFIBUS specialists only.
 The standard timeout settings are accepted and the configuration is completed.

The "PROFIBUS Control Panel" dialog opens and the symbolic name of the
Fieldgate is assigned to the "FG series/PROFIgate" item.

5. Click Apply.
 The configuration is saved. The Fieldgate FXA720 device is ready if a green tick

appears next to the symbolic name. If a red tick appears, check whether the
PROFIBUS scan is switched off.

6. For single-channel Fieldgates, click OK.

The configuration is saved and the configuration window closes.
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21.3  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the PROFIdtm DPV1 item and click OK.
 The PROFIdtm DPV1 is added to the network.

If the Fieldgate FXA720 has not yet been set up, it can be set up now.

5. In the "Network" dialog, right-click the PROFIdtm DPV1 item.
 A drop-down list opens.
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6. Select Configuration.
 The "PROFIdtm DPV1 (Configuration)" dialog opens.

7. Check that the PROFIBUS bus parameters are exactly the same as those used in any
Master Class 1 in the network. The default parameters are the ones recommended
for use with a particular baud rate. They can be adjusted by deactivating the
automatic defaults.
Select Board-Name from the drop-down menu.

8. Enter the PROFIBUS Address of the Fieldgate FXA720.

9. Select the Baud Rate that is used by the PROFIBUS network.

10. Enter the Start and End Address for the scan range and click OK.
 The changes are saved and FieldCare returns to the "Network" dialog.

11. In the "Network" dialog, right-click the PROFIdtm DPV1 item.
 A drop-down list opens.

12. Select Create Network.
 FieldCare now scans the network and adds all devices found to the network.

13. In the "Network" dialog, right-click a device.
 A drop-down list opens.

14. Select Connect.
 The connection to the device is established.
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15. In the "Network" dialog, right-click a device.
 A drop-down list opens.

16. Select Online Parameterize.
 The DeviceDTM opens.

17. Save the project →   13.
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22  PROFIBUS DP/PA via Fieldgate SFG500

22.1  Use case
Fieldgate SFG500 is connected to the Ethernet backbone via the LAN 1 Ethernet socket
and the PROFIBUS DP segment. The segment itself is connected to a PLC or DCS, which
acts as Class 1 master. PROFIBUS PA devices are connected to the network via the coupler.

To see all the devices on the PROFIBUS DP/PA segment, FieldCare requires:
• SFGNetwork DTM
• PROFIBUS DeviceDTMs
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 32 Fieldgate SFG500 access to a PROFIBUS DP network

1 FieldCare
2 Ethernet
3 FieldgateSFG500
4 PROFIBUS DP
5 PROFIBUS PA
6 Transparent DP/PA coupler
7 Controller with I/O cards

22.2  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the SFGNetwork item and click OK.
 The SFGNetwork is added to the network.

5. In the "Network" dialog, right-click the SFG500 Network item.
 A drop-down list opens.
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6. Select Create Network.
 The Ethernet network is scanned and all the available Fieldgate SFG500s and the

connected devices are added.

If there is only one Fieldgate SFG500 in the network, the connection is
established and the "SFG500 (Configuration)" dialog opens.

If no DTM has been found, it is possible that the UDP ports are blocked.

For detailed information on "FieldCare SFE500 Windows Firewall": Operating
Instructions →   11

7. In the "Network" dialog, right-click the SFG500 Network item.
 A drop-down list opens.

8. Select Add Device and click OK.
 The CommDTM is added to the network.

9. If several Fieldgate SFG500s and connected devices are found, these are
automatically added to the network.
If any of the devices has a DTM whose quality is less than "1", the Scanning Result
dialog opens. Click OK before the devices are added to the network.
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10. If only one device is found, the DTM is opened automatically.
If more than one device is found, the "Connect After Scanning" message appears. Click
OK to acknowledge this message.


11. In the "Network" dialog, right-click a device.
 A drop-down list opens.

12. Select Connect.
 The connection to the device is established. This is indicated by a green arrow.

13. In the "Network" dialog, right-click a device.
 A drop-down list opens.

14. Select Online Parameterize.
 The DeviceDTM opens.

The device can now be configured.

15. Save the project →   13.
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23  PROFIBUS DP/PA via multiple Fieldgate
SFG500 devices

23.1  Use case
For simplicity the devices connected to segments 2 – 5 are not shown. All Fieldgate
SFG500s are connected to the Ethernet backbone via the LAN 1 Ethernet socket and share
a common Ethernet IP address domain. One Fieldgate SFG500 is connected to each
PROFIBUS DP segment. The PROFIBUS DP segments do not necessarily have to be
connected to a single PLC. PROFIBUS PA devices are connected to the PROFIBUS DP
segments via couplers.

To see all the devices on the PROFIBUS DP/PA segment, FieldCare requires:
• SFGNetwork DTM
• PROFIBUS DeviceDTMs
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 33 Fieldgate SFG500 access to multiple PROFIBUS DP networks

1 FieldCare
2 Ethernet
3 FieldgateSFG500
4 PROFIBUS DP with segment 1-5
5 DP/PA coupler
6 PROFIBUS PA
7 PLC/DCS
8 Control network

23.2  Connection procedure
Establishing a connection
1. Create a project →   13.
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2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the SFGNetwork item and click OK.
 The SFGNetwork is added to the network.

5. In the "Network" dialog, right-click SFGNetwork.
 A drop-down list opens.

6. Select Connect.

7. The connection to the device is established and is indicated by a green arrow.

8. In the "Network" dialog, right-click the SFG500Network item.
 A drop-down list opens.

9. Select Create Network.
 FieldCare scans the Ethernet network.
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10. If more than one device is found, the Connect After Scanning message appears.
Click OK.


FieldCare adds the Fieldgate SFG500s found and the connected devices to the
network.

If no DTM has been found, it is possible that the UDP ports are blocked.

For detailed information on "FieldCare SFE500 Windows Firewall": Operating
Instructions →   11

11. If any of the devices has a DTM whose quality is less than "1", the Scanning Result
dialog opens.
Click OK before the devices are added to the network.
 The "Network" dialog opens.

12. Save the project →   13.
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24  PROFIBUS DP/PA via Fieldgate SFG500 and
Siemens link

24.1  Use case
When operating with a Siemens DP/PA coupler or link, the component architecture can be
as shown in the following graphic.

The Fieldgate SFG500 is connected to the Ethernet backbone via the LAN 1 Ethernet
socket. PROFIBUS PA devices are connected to the network via the Siemens coupler/link.
The same architecture can be used for Fieldgate FXA720 in combination with Siemens
DP/PA link.

To see all the devices on the PROFIBUS DP/PA segment, FieldCare requires:
• SFGNetwork DTM
• PROFIBUS CommDTM
• PROFIBUS DeviceDTMs
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 34 Fieldgate SFG500 access to a PROFIBUS DP network via Siemens coupler/link

1 FieldCare
2 Ethernet
3 FieldgateSFG500
4 PROFIBUS DP
5 PROFIBUS PA
6 Siemens link/ DP/PA coupler
7 PLC/DCS
8 Control network

24.2  Connection procedure
Establishing a connection
1. Create a project →   13.
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2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the SFGNetwork item and click OK.
 The SFGNetwork is added to the network.

5. In the "Network" dialog, right-click SFGNetwork.
 A drop-down list opens.

6. Select Connect.

7. The connection to the device is established and is indicated by a green arrow.

8. In the "Network" dialog, right-click the SFG500Network item.
 A drop-down list opens.
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9. Select Create Network.
 FieldCare scans the PROFIBUS network for the Siemens link and the "Create

Network - Scan Result" dialog opens.

If no DTM has been found, it is possible that the UDP ports are blocked.

For detailed information on "FieldCare SFE500 Windows Firewall": Operating
Instructions →   11

10. Click OK.
 The CommDTM of the DP/PA link is added to the network.

11. In the "Network" dialog, right-click the DP/PA Link item.
 A drop-down list opens.

12. Select Create Network.
 The segment to which the DP/PA link is connected is scanned for devices.

The "Create Network - Scanning Result" dialog opens.
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13. Click OK.
 If the "Connect After Scanning" option is selected under Extras the "Connect After

Scanning" dialog opens.

The devices are added to the network.

The DeviceDTMs can be opened.

14. Save the project →   13.
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25  PROFIBUS DP/PA and HART via Fieldgate
SFG500 and Siemens ET200M/iSP

25.1  Use case
This chapter describes how FieldCare should be configured for a plant that uses a Siemens
ET200M/iSP-type Remote I/O. The PC with FieldCare installed is connected to an SFG500
via Ethernet. The SFG500 is connected via Profibus DP to an ET200M/iSP, which is
connected to the field devices via HART. A cyclic master is required for the operation of the
plant.

1 32 4 5 6

 35 Fieldgate SFG500 access to Siemens ET200M/iSP

1 FieldCare
2 Ethernet/IP
3 FieldgateSFG500
4 PROFIBUS DP
5 Master
6 Siemens ET200 Remote I/O

25.2  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the SFGNetwork item and click OK.
 The SFGNetwork is added to the network.

5. In the "Network" dialog, right-click SFGNetwork.
 A drop-down list opens.

6. Select Connect.
 The connection to the device is established and is indicated by a green arrow.

7. In the "Network" dialog, right-click the SFG500Network item.
 A drop-down list opens.

8. Select Create Network.
 When you scan at the SFGNetwork level, all the SFG500s on the Ethernet are

found. Then scan again on the SFG500 level to see the ET200M/iSP.
FieldCare scans the Ethernet network and displays the available devices.

9. In the "Network" dialog, right-click CommDTM.
 A drop-down list opens.
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10. Select Create Network.
 The "Communication Channel" dialog opens.

11. Select all the channels that should be scanned.
 The channels are scanned. The HART devices connected to the ET200M/iSP are

displayed and can be used.

12. Save the project →   13.
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26  PROFIBUS DP/PA and HART via Fieldgate
SFG500 and Turck Remote I/O

26.1  Use case
When operating with a Turck EXCOM Remote I/O a component architecture can be used.
The Fieldgate SFG500 is connected to the Ethernet backbone via the LAN 1 Ethernet
socket. PROFIBUS PA devices are connected to the network via e.g. a transparent coupler.
The HART devices (4 to 20 mA) are connected point-to-point to the Turck Remote I/O
which in turn is connected to the PROFIBUS DP segment.

To see all the devices on the PROFIBUS DP/PA segment, FieldCare requires:
• SFGNetwork DTM
• Licensed Turck CommDTM EXCOM
• PROFIBUS DeviceDTMs
• HART DeviceDTMs
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 36 Fieldgate SFG500 access to HART devices via Turck Remote I/O

1 Control network
2 PLC/DCS
3 FieldCare
4 Fieldgate SFG500 Access Point
5 Ethernet
6 PROFIBUS DP
7 Turck EXCOM Remote I/O
8 HART 4 to 20 mA
9 DP/PA coupler
10 PROFIBUS PA

26.2  Connection procedure
Establishing a connection
1. Create a project →   13.
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2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the SFGNetwork item and click OK.
 The SFGNetwork is added to the network.

5. In the "Network" dialog, right-click SFGNetwork.
 A drop-down list opens.

6. Select Connect.
 The connection to the device is established and is indicated by a green arrow.

7. In the "Network" dialog, right-click to select the SFGNetwork item.
 A drop-down list opens.

8. Select Create Network.
 FieldCare scans the Ethernet network and displays the available devices.

If only one Fieldgate is found, its DTM is opened automatically.
Alternatively, the CommDTM can be added manually.

If no DTM has been found, it is possible that the UDP ports are blocked.

For detailed information on "FieldCare SFE500 Windows Firewall": Operating
Instructions →   11

9. In the "Network" dialog, right-click SFG500.
 A drop-down list opens.

10. Select Connect.
 The connection to the device is established and is indicated by a green arrow.
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11. In the "Network" dialog, right-click SFG500.
 A drop-down list opens.

12. Select Create Network.
 FieldCare scans the PROFIBUS network for the Turck Remote I/O.

The CommDTM of the excom is added to the network.

If the message "Connect After Scanning" appears, this can be selected or not. It is
advisable to disable this option.

 37 Scan FieldCare/excom if there is a connection after scanning.

 38 Scan FieldCare/excom if there is no connection after scanning.

13. If the "Connect After Scanning" option is selected under Extras the "Connect After
Scanning" dialog opens.
Click OK.


14. In the "Network" dialog, right-click the excom DP-N item.
 A drop-down list opens.

15. Select Connect.
 The connection to the device is established and is indicated by a green arrow.

16. In the "Network" dialog, right-click the excom DP-N item.
 A drop-down list opens.
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17. Select Create Network.
 The devices found are added to the network.

18. If the "Connect After Scanning" option is selected under Extras the "Connect After
Scanning" dialog opens.
Click OK.


19. In the "Network" dialog, right-click an excom module.

20. Select Connection.

21. In the "Network" dialog, right-click an excom module.

22. Select Create Network.

23. Save the project →   13.

Other functions via HART devices
1. In the "Network" dialog, right-click the excom DP-N item.

 A drop-down list opens.

2. Select Other Functions → HART Devices.
 The "Excom DP-N (HART-LiveList)" dialog opens.

Excom does not have a HART LiveList as an additional function.

Turck excom Remote I/O is successfully tested with:
• FieldCare SFE500

– FieldCare version 2.11.00
– DTM for Fieldgate SFG500 version 1.09.00
– DTM for excom Remote I/O system version 1.12.4

• FieldgateSFG500
Fieldgate SFG500 with firmware 01.09.00-03131

• Turck excom Remote I/O system
Turck GPD-IS with Firmware 2.2
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27  PROFIBUS DP/PA and HART via Fieldgate
SFG500 and Stahl Remote I/O

27.1  Use case
When operating with a Stahl CPM 9440 Remote I/O the component architecture can be as
shown in the following graphic. The Fieldgate SFG500 is connected to the Ethernet
backbone via the LAN 1 Ethernet socket. PROFIBUS PA devices are connected to the
network via e.g. a transparent coupler. The HART devices (4 to 20 mA) are connected
point-to-point to the Stahl Remote I/O which in turn is connected to the PROFIBUS DP
segment.

To see all the devices on the PROFIBUS DP/PA segment, FieldCare requires:
• SFGNetwork DTM
• PROFIBUS CommDTM
• PROFIBUS DeviceDTMs
• HART DeviceDTMs
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 39 Fieldgate SFG500 access to HART devices via Stahl Remote I/O

1 Control network
2 PLC/DCS
3 FieldCare
4 Fieldgate SFG500 Access Point
5 Ethernet
6 PROFIBUS DP
7 Stahl CPM 9440 Remote I/O
8 HART 4 to 20 mA
9 DP/PA coupler
10 PROFIBUS PA

27.2  Connection procedure
Establishing a connection
1. Create a project →   13.
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2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the SFGNetwork item and click OK.
 The SFGNetwork is added to the network.

5. In the "Network" dialog, right-click SFGNetwork.
 A drop-down list opens.

6. Select Connect.
 The connection to the device is established and is indicated by a green arrow.

7. In the "Network" dialog, right-click to select the SFG500 Network item.
 A drop-down list opens.

8. Select Create Network.
 FieldCare scans the Ethernet network and displays the available devices.

If only one Fieldgate is found, its DTM is opened automatically.
Alternatively, the CommDTM can be added manually.

If no DTM has been found, it is possible that the UDP ports are blocked.

For detailed information on "FieldCare SFE500 Windows Firewall": Operating
Instructions →   11

9. In the "Network" dialog, right-click SFG500.
 A drop-down list opens.

10. Select Connect.
 The connection to the device is established and is indicated by a green arrow.
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11. In the "Network" dialog, right-click SFG500.
 A drop-down list opens.

12. Select Create Network.
 FieldCare scans the PROFIBUS network for the Stahl Remote I/O.

The "Create Network - Scanning Result" dialog opens.

13. Click OK.
 The CommDTM of the Stahl Remote I/O is added to the network.

14. If more than one device is found, the "Connect After Scanning" message appears.
Click OK.

15. In the "Network" dialog, right-click to select the Stahl Remote I/O item.
 A drop-down list opens.

16. Select Create Network.
 The segment to which the Stahl Remote I/O is connected is scanned for devices.

The "Create Network - Scanning Result" dialog opens.

17. Click OK.
 The CommDTM is added to the network.
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18. If the "Connect After Scanning" option is selected under Extras the "Connect After
Scanning" dialog opens.
Click OK.


19. In the "Network" dialog, right-click to select the CPM 9440 item.
 A drop-down list opens.

20. Select Connect.
 The connection to the device is established and is indicated by a green arrow.

21. In the "Network" dialog, right-click to select the CPM 9440 item.
 A drop-down list opens.

22. Select Create Network.
 The "Select Communication Channel" dialog appears.

23. Select Communication Channel.
 The devices found are added to the network.

24. If the "Connect After Scanning" option is selected under Extras the "Connect After
Scanning" dialog opens.
Click OK.


25. Save the project →   13.

Other functions via HART devices
1. In the "Network" dialog, right-click to select the CPM 9440 item.

 A drop-down list opens.
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2. Select Other Functions → HART Devices.
 The "CPM 9440 (HART-LiveList)" dialog opens.
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28  PROFIBUS DP/PA via Softing PBproUSB
modem

28.1  Use case
The Softing PBproUSB modem allows a computer or laptop to connect to a PROFIBUS DP
segment via USB

The PROFIBUS PA devices can be accessed via a DP/PA coupler.

To see all the devices on the segment of the PROFIBUS DP/PA, FieldCare requires:
• PROFIBUS DeviceDTMs
• PROFIdtm DPV1 CommDTM
• PROFIBUS driver PROFIboard

1 2 3 4 5

 40 Connection of a PBproUSB modem with a PROFIBUS PA segment

1 FieldCare
2 USB
3 PBproUSB modem
4 DP/PA coupler
5 PROFIBUS PA

28.2  Connection procedure
PBproUSB must be commissioned before it can be used. For this, the user calls the
PROFIBUS Control Panel Applet from the PROFIBUS DPV1 CommDTM.

Starting the PROFIBUS Control Panel
1. Start the PROFIBUS Control Panel Applet.
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2. In the "Network" dialog, right-click PROFIBUS DPV1 CommDTM.
 A drop-down list opens.

3. Select Other Functions → PROFIBUS Control Panel Applet.
 The "PROFIBUS Control Panel" dialog opens.

For this to happen, the PROFIBUS DVP1 CommDTM must have been added to the
HOST PC beforehand.

PROFIBUS set-up
1. In the "PROFIBUS Control Panel" dialog, select the PBproUSB item and click Add.

 The "Select Node Name" dialog opens.

2. Enter a symbolic node name for the PROFIBUS DP channel (default value: Node 0)
and click Next.
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3. Do not change the default settings (auto) for the serial number of the device.
Click Finish.
 The "PROFIBUS Control Panel" dialog returns and the symbolic name of the

PBproUSB modem is assigned to the PBproUSB item.

4. Click Apply.
 The configuration is saved. The device is ready if a green tick appears next to the

symbolic name. If a red tick appears, check whether the PROFIBUS scan is
switched off.

5. For single-channel Fieldgates, click OK.

The configuration is saved and the configuration window closes.

28.3  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the PROFIdtm DPV1 item and click OK.
 The PROFIdtm DPV1 is added to the network.

5. In the "Network" dialog, click the PROFIdtm DPV1 item.
 The configuration dialog of the DTM opens.

The Node Name (default: Node0) entered previously in the PROFIBUS Control
Panel must be selected in the "Board Name" field. The other parameters must be
checked and modified as they can vary depending on the plant.

6. In the "Network" dialog, right-click the PROFIdtm DPV1 item.
 A drop-down list opens.
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7. Select Create Network.
 FieldCare now scans the network and adds all devices found to the network.

Save the project →   13.
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29  PROFIBUS DP via PROFIBUS modem and
WAGO Remote I/O

29.1  Use case
This chapter describes how FieldCare should be configured for a plant that uses a WAGO
Remote I/O. The PC with FieldCare installed is connected to a PROFIBUS modem via
Ethernet. A Softing PBproUSB, for example, can be used for this. The modem is connected
to the WAGO Remote I/O via PROFIBUS DP. The WAGO Remote I/O is connected to HART
field devices by HART via one or more WAGO modules. A cyclic master is essential for the
operation of the plant. A PROCENTEC ProfiCore, for example, can be used for this.

1 32 4 5 6

 41 Access to PROFIBUS DP via PROFIBUS modem and WAGO Remote I/O

1 FieldCare
2 Ethernet/IP
3 PROCENTEC ProfiCore
4 Softing modem
5 PROFIBUS DP
6 WAGO Remote I/O

The plant described in this chapter uses a Softing profiUSB with commDTM PROFIdtm
DPV1 as the PROFIBUS modem and a PROCENTEC ProfiCore as the cyclic master.
Alternatively, other suitable PROFIBUS devices can also be used.

29.2  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the DTM modem and click OK. If a Softing modem is used, PROFIdtm DP-V1 is
the correct DTM.
 The modem is added to the network.

5. In the "Network" dialog, right-click PROFIdtm DPV1.
 A drop-down list opens.

6. Select Configuration.
 The "Configuration" dialog opens.

7. Adjust the configuration parameters of the modem individually.

In the case of the Softing modem, these are the timing parameter and the baud rate in
particular. These parameters can vary depending on the plant. If these parameters are
not correct, the following settings cannot be made correctly since the device list is
empty, for instance.

8. Select the modem in the "Network" dialog.
 A drop-down list opens.

9. Select Create Network.
 The Remote I/O is found and appears in the structure.

10. Select Remote I/O and click Disconnect in the context menu.
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11. Select Remote I/O and click Configuration.
 The "WAGO Configuration" dialog opens.

12. Select the "Module Configuration" tab in the dialog. The first slot (1) is occupied by
the WAGO head module and cannot be edited. Set all the modules on the head
module.

13. Select Remote I/O and click Connect in the context menu.
 Remote I/O is online: this is indicated by a green background.

14. Select Devicelist and click Additional Function.
 The Devicelist of the Remote I/O opens.

Recursive scanning cannot be performed with the Wago Remote I/O. Therefore, all
the devices connected to the Remote I/O and displayed in the device list must be
added manually.

15. Click Add Device in the context menu.
 The "Add New Device" dialog appears.

16. Select Device.
 The "Assign Device to Channel" dialog opens.

17. Assign the channel to the device.
 The device appears in the network structure and can be used.
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30  PROFIBUS DP via PROCENTEC ProfiCore

30.1  Use case
This chapter describes how FieldCare should be configured for a plant that uses a
PROCENTEC ProfiCore. The PC with FieldCare installed is connected to a PROCENTEC
ProfiCore via Ethernet. The ProfiCore is connected via PROFIBUS DP to a PROFIBUS DP/PA
coupler which is connected to the field devices via PROFIBUS PA.

The following software packages must be installed and configured on the PC:
• PCD setup
• CommDTM PROCENTEC DP-V1 master
• ProfiTrace

These can be downloaded from the PROCENTEC site at www.procentec.com

1 2 3 4 5

 42 Access to PROFIBUS DP via PROCENTEC ProfiCore

1 FieldCare
2 USB
3 PROCENTEC ProfiCore
4 PROFIBUS DP
5 DP/PA coupler

30.2  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4.

Click the PCD icon in the bottom right of the start bar.
 The "PCD Server" dialog opens.

5. Click Add.
 The "Interface Settings" dialog opens.

6. Enter values for the fields Interface Name (user-definable) , Driver = Profitrace/…,
serial number of the Procentec Device and confirm.
 The interface is created and can be assigned.

7. In the "Network" dialog, right-click PROFIdtm.
 A drop-down list opens.
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8. Select Configuration.
 The "Configuration" dialog opens.

9. Click on the Bus Parameter tab.
 The bus parameters appear.

10. In the "Bord Name" field, select the Interface Name entered and click Start.
 The bus parameters are read and saved.

11. In the "Network" dialog, right-click PROFIdtm.
 A drop-down list opens.

12. Select Create Network.

The network is scanned and all the field devices connected to the PROCENTEC ProfiCore
are displayed and can be used.
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31  PROFIBUS via modem PBI-Plus/smar

31.1  Use case
This chapter describes how FieldCare should be configured for a smar PBI-Plus PROFIBUS
modem. The PC with FieldCare installed is connected to a smar PBI-Plus PROFIBUS modem
via USB. The PROFIBUS modem is connected directly to the field devices by PROFIBUS
technology via PROFIBUS PA.

The following software packages must be installed and configured on the PC:
• Device library CD smar Device Library v1_23 – PROFIBUS
• Device driver Driver_USB.rar

1

2

3

4

 43 Access to PROFIBUS via smar modem PBI-Plus

1 FieldCare
2 USB
3 PROFIBUS modem smar PBI-Plus
4 PROFIBUS PA

The software packages can be downloaded from the manufacturer's website
www.smar.com or from its support website support.smar.com.

Installation of the smar device library
Start setup as an administrator, default installation.

Connect PBI-Plus modem with PC
A popup appears.

The popup does not appear if the modem is not connected to a PROFIBUS device.

Installing the USB driver (Windows 7)
Unpack to Driver_USB.rar \Driver_USB\Windows 7 (64 or 32 bit version).

In Windows Device Manager, set the USB driver of the USB port: \Driver_USB\Windows 7
(64 or 32 bit version).
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31.2  Connection procedure
In the Device Manager specify the port via which the PBI-Plus is connected to the PC
via USB (here COM2).

The picklists do not expand in the edit mode. The selected value is entered using the
keyboard. 1-9 for port, L/N for interface. Furthermore, the device must be offline for
these settings.

9 is the maximum value for the port. If the port in the Device Manager is higher, the
modem must be connected manually beforehand with another port via the advanced
port settings, permitted value range is 1 - 9.

Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select PBI and click OK.
 PBI is added to the network.

5. In the "Network" dialog, right-click PBI-Plus.
 A drop-down list opens.

6. Select Offline Parameterize.
 The "PBI (Offline Parameterize)" dialog opens.

7. Set the Port and Interface and click Write.

8. In the "Network" dialog, right-click PBI-Plus.
 A drop-down list opens.

9. Select Add Device.
 The "Add New Device" dialog opens.

10. Select the suitable device DTM.

The device can now be connected and used.

The version number and parameter (bus address) must match as otherwise it might
not be possible to establish a connection to the device.
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32  PROFIBUS via SFG500 with the Heartbeat
VerificationDTM

32.1  Use case
The following example shows how the VerificationDTM is used in FieldCare. In the plant, a
PROFIBUS device is directly connected to the PC via a Fieldgate SFG500. It is possible to
transfer the Heartbeat data from the PC to the W@M portal via the VerificationDTM
upload function.

Other areas of application of the VerificationDTM include plants in which:
• HART devices are connected to the Fieldgate SFG500 via a PROFIBUS HART gateway
• HART devices via a gateway (e.g. SFG250 IsNET) with PC/FieldCare
• or Ethernet/IP PROFINET networks are connected to the PC/FieldCare via CDI TCP/IP

DTM

Networks that communicate via FOUNDATION Fieldbus are not supported by the
VerificationDTM. Additional information can be found in the documentation for the
VerificationDTM.
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5

 44 Access to PROFIBUS via SFG500 with the Heartbeat VerificationDTM

1 FieldCare
2 W@M Portal
3 FieldgateSFG500
4 PROFIBUS DP
5 PLC

32.2  Connection procedure
System requirements: The VerificationDTM must be installed on the PC, the setup for
the VerificationDTM can be found in the FieldCare Download Area of the
Endress+Hauser website. https://portal.endress.com/webdownload/
FieldCareDownloadGui/

32.2.1  Scanning the network

Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.



Tutorial for FieldCare projects PROFIBUS via SFG500 with the Heartbeat VerificationDTM

Endress+Hauser 129

3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the SFGNetwork item and click OK.
 The SFGNetwork is added to the network.

5. In the "Network" dialog, right-click SFGNetwork.
 A drop-down list opens.

6. Select Create Network.
 The SFGNetwork is scanned, all the Fieldgate SFG500s connected in the network,

along with the individual devices, are found and shown in the network view.

In the example below, a Fieldgate SFG500 with a Promag 100 heartbeat device is
found at address 25. A VerificationDTM is assigned to this device. An additional,
separate VerificationDTM must be assigned in each case for every additional
Heartbeat device in the network. A unique DTM address guarantees the assignment.

32.2.2  Adding/configuring the VerificationDTM
The steps below are repeated for all the heartbeat devices in an SFG500 network:

1. In the "Network" dialog, right-click SFGNetwork.
 A drop-down list opens.

2. Select Add Device.
 The "Add New Device" dialog opens.
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3. Select VerificationDTM.
 The VerificationDTM is added to the network.

4. In the "Network" dialog, right-click SFGNetwork.
 A drop-down list opens.

5. Select Other Functions → Disconnect.
 SFG500 is disconnected.

It is only possible to select the Set DTM Address item if you are disconnected from
the SFG500.

6. In the "Network" dialog, right-click SFGNetwork.
 A drop-down list opens.

7. Select Other Functions → Set DTM Address.
 The dialog of the SFG500 opens.

This contains a list of all the devices and verification DTMs that are assigned to
the Fieldgate SFG500.
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8. Select the DTM that has just been added. Enter the DTM address and press Enter to
confirm. Then click Update.
 The DTM is updated in the network.

Once a VerificationDTM has been added and configured for every heartbeat
device, they can be used to read out the heartbeat data.

The DTM address and device address must match (here = 25 / Promag100) to be able
to assign the VerificationDTM to a device.

The option "Show archive tree" must be selected in the top left in the DTM toolbar so
that all the functions of the DTM are displayed, particularly the Verification and
Archive File tabs.

32.2.3  Reading out the heartbeat data
1. In the "Network" dialog, right-click VerificationDTM.

 A drop-down list opens.

2. Select Connect Device.
 The device is connected.

3. Double-click VerificationDTM.
 VerificationDTM opens.

After selecting one of the data records 9-16, the heartbeat data are read automatically and
cached in the selected data record. In this way, different versions of the device parameters
can be stored in the data records for later use or analysis.

32.2.4  Uploading the heartbeat data to W@M
The stored heartbeat data of a data record can be transferred to the W@M Portal.
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1.

In the "VerificationDTM" dialog, switch to the Layout Options tab.
 A list of data records opens.

2. Select the data records that should be transferred to W@M.

3. In the "VerificationDTM" dialog, switch to the Print Options tab and select Print to
W@M.

4. Click the Print Button in the title bar.

Start uploading to W@M.

The devices can be assigned between FieldCare and W@M via the TAG and the serial
number. These must be provided in W@M.

FieldCare must be configured for integration of Heartbeat verification in W@M
Portal.

For detailed information on "Integrating Heartbeat verification in W@M Portal", see
FieldCare Operating Instructions. →   11

Verifying the upload
1. In the "Network" dialog, right-click the device to be verified.

 A drop-down list opens.

2. Select Device in Web → Show Device-specific Details.
 W@M is loaded and the device data are displayed. The "Attachment" tab contains

a list of the reports most recently transferred with the heartbeat data of the
device.
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33  FOUNDATION Fieldbus H1 via Field Controller
SFC162

33.1  Use case
When operating as a visitor, the Field Controller SFC162 provides a parallel path to
devices in an existing system and is used to commission devices, to change their settings or
to monitor their condition. This assumes that the system is operating, i.e. a project has
been downloaded to the Field Controller and devices.

The Field Controller SFC162 is normally used to configure the transducer blocks only. For
some devices, the Field Controller SFC162 can also be used to configure the input and
output blocks, but normally not the logic and control blocks.

For detailed information on "Field Controller SFC162": Operating Instructions →   11

To see all the devices on the FOUNDATION Fieldbus H1 segment, FieldCare requires:
• FOUNDATION Fieldbus CommDTM
• FOUNDATION Fieldbus DeviceDTMs
• For devices without native DTMs, the iDTM for FOUNDATION Fieldbus
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 45 Field Controller SFC162 access to a FOUNDATION Fieldbus H1 network

1 FieldCare
2 Field Controller SFC162
3 Ethernet
4 FOUNDATION Fieldbus H1
5 DCS

33.2  Commissioning the Field Controller SFC162

33.2.1  Setting up the IP address of the Field Controller SFC162
For this procedure, it is necessary to know the IP address of the Fieldgate within the
control network.

Do not restart the Field Controller SFC162 with the new address before Visitor mode
has been selected.
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Setting up the IP address of the Field Controller SFC162

‣ Set the IP address of the computer to the same domain as the Field Controller SFC162's
default address 192.168.164.100. See Appendix A or consult your system
administrator for information on this procedure.

For detailed information on "Setting up the IP address": Getting Started →   11

2. If you have Application Designer installed on your computer, call HS Network Setup:
Select Programs → Endress+Hauser → ControlCare → Tools → HS Network Setup.
Otherwise call up the Web server and enter the address 192.168.164.100 . Then
proceed with Step 5.
 HS Network Setup starts and searches for devices in the Ethernet network.

All devices in the network appear, irrespective of their IP domain.

If this is not the case:
• Disable the proxy server of the Web browser
• Windows firewalls may not block the execution of the program
• Check cables and switches
• If there are several Field Controllers with the same IP address, only connect one

with the network

3. If the computer has more than one NIC, it is necessary to select the card you want to
use for communication with the Field Controllers.
Tick Active NIC and click Save.

4. Note the IP address of the active card as this is used by FieldCare.

5. Double-click the Field Controller whose address is to be changed or enter
192.168.164.100 in the Web browser.
 The Web browser of the Field Controller opens.

The Web server only opens if the host computer and the Field Controller have
IP addresses in the same IP domain.
If the Web server still does not open, make sure that the proxy server of the
browser is disabled.

6. Expand the "Setup" node and click Network.
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7. Enter pcps as the user name and pcps as the password.
 The "Network Configuration" dialog opens.

8. Enter the required IP address.

9. Enter a netmask (e.g. 255.0.0.0., but usually 255.255.255.0).

10. If required, enter a default gateway (usually xxx.xxx.xxx.1 selected domain) and
click Update.

11. Confirm the message that the Field Controller SFC162 must be restarted.

The IP address is set up.

33.2.2  Selecting the Visitor mode
There can be up to four Field Controller SFC162s in any one network. However, each
controller must be assigned a different H1 address by running the option under Step
2 above.

Selecting the Visitor mode
1. Return to the home page and click Change.

 The frameware home screen opens.

2. Select Factory init in Visitor mode (H1-address 0xFC) and click Restart.

3. Enter pcps as the user name and pcps as the password to confirm the Field
Controller SFC162 restart.
 The Field Controller SFC162 changes its mode from Controller (default setting)

to Visitor.
The Field Controller is restarted as Visitor.

4. Set the address of the host computer to the same domain as that of the Field
Controller SFC162 Visitor (e.g. 10.125.35.200).
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33.2.3  Selecting the network interface card (NIC) for FieldCare
If the host computer has more than one NIC, the one used for the Ethernet connection
to the controller and visitor must be specified, otherwise the applications running on
Ethernet select the first they find by default. For Application Designer, ticking and
storing the active NIC in HS Network Setup causes the associated .ini files to be
updated.

For FieldCare these changes have to be made by hand.

Selecting the network interface card (NIC) for FieldCare
1. Select Program Files → Common Files →Codewrights → HSEsvr2 →

endressoleserver.ini.
2. Open the endressoleserver.ini file with Notepad.

3. Search for the NIC Adapter entry.

4. Set a ; in front of the line DEFAULT_NIC = NIC.

5. Remove the ; from the line NIC = and add the NIC address (e.g. NIC =
10.125.35.200).


6. Save and close the endressoleserver.ini file.

The Visitor Function can now be used.

33.3  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the SFC162 CommDTM item and click OK.
 The SFGNetwork is added to the network.

5. In the "Network" dialog, right-click SFC162 CommDTM.
 A drop-down list opens.

6. Select Configuration.
 FieldCare scans the network for all the Ethernet devices and displays them in the

list of HS devices.

7. To connect the Field Controller SFC162 Visitor, click the appropriate line (e.g.
10.125.35.190).
 A tick appears next to the Field Controller SFC162 Visitor and the entry appears

green.

8. In the "Network" dialog, right-click SFC162 CommDTM.
 A drop-down list opens.
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9. Select Create Network.
 The "Select Communication Channel" dialog opens.

10. Select the channels to be scanned. Deselect all other channels and click OK.
 The scanning starts.

FieldCare scans the selected channels and adds the devices found to the network.

11. In the "Network" dialog, right-click a device.
 A drop-down list opens.

12. Select Connect.
 The arrows next to the device appear green.

13. In the "Network" dialog, right-click a device.
 A drop-down list opens.
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14. Select Online Parameterize.
 The DeviceDTM is added to the network tree and the DTM opens.

The device can now be configured.

For detailed information on "Field Controller SFC162 Visitor": Operating Instructions
→   11

33.4  Upload the project
After the devices have been configured, their settings must be uploaded to the Field
Controller SFC162 and engineering tool. Depending upon the tool and the task
(commissioning or replacement) this can be normally done for the entire fieldbus or for
individual devices.

For detailed information on "Field Controller SFC162 Visitor": Operating Instructions
→   11
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34  FOUNDATION Fieldbus H1 Bench mode via
Field Controller SFC162

34.1  Use case
In Bench mode operation, two scenarios exist:
• Devices are configured prior to being installed in the plant
• Devices are already installed in the plant but the Field Controller SFC162 is not in

operation

In the first case, the devices will normally be configured on a point-to-point basis, i.e. one
device at a time, unless a powered network structure exists. In the second case, the
network exists, but it must be powered before the devices can be configured.

As far as the Field Controller SFC162 is concerned, Bench mode operation requires that it
operates as a controller, since there will normally be no other LAS (link active scheduler)
in the network.

To see all the devices on the FOUNDATION Fieldbus H1 segment, FieldCare requires:
• FOUNDATION Fieldbus CommDTM
• FOUNDATION Fieldbus DeviceDTMs
• For devices without native DTMs, the iDTM for FOUNDATION Fieldbus

C
o

n
tr

o
lC

a
re

 S
F

C
1

6
2

ON

E
T

H
R

S
-2

3
2

RS-232 TX

ETH LNK

ETH TX

FF H1 - 1

FF H1 - 2

FF H1 - 3

FF H1 - 4

STDBY

F
A

IL
R

U
N

H
L
D

F
R

C

See Manual

!

1

2

3

4

 46 Bench mode architecture showing point-to-point connection

1 FieldCare
2 Ethernet
3 Field Controller SFC162
4 FOUNDATION Fieldbus H1

This chapter describes the point-to-point scenario. It shows how a device tag and device
address can be assigned to a device. For information about the configuration of the
devices, please refer to the appropriate manual.

The DeviceDTMs differ from device to device in the functions which can be configured:
• All DTMs allow the configuration of the resource and transducer blocks
• Some DTMs allow the configuration of the device input/output blocks
• To date, no DTM allows the configuration of the tag and address. This can only be done

with the Field Controller SFC162 CommDTM

The upload to the control system may also differ depending upon the manufacturer, type
and condition of the device. Endress+Hauser devices delivered fresh from the factory will
usually upload all the function blocks they support including logic and control blocks,
although the latter cannot be configured via DTMs.

Should a device have been subject to a download from a control system, then any block not
instantiated by the engineering tool will not be part of the upload. For a TMT162
temperature transmitter, for example, if only one analog input block has been instantiated
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for a project, only this block will be uploaded, although three blocks are offered in the
DTM. Configuring the two other blocks in FieldCare will not cause them to be uploaded.

34.2  Commissioning the Field Controller SFC162

34.2.1  Setting up the IP address of the Field Controller SFC162
For this procedure, it is necessary to know the IP address of the Fieldgate within the
control network.

Do not restart the Field Controller SFC162 with the new address before Visitor mode
has been selected.

For detailed information on "Setting up the FieldCare IP address": Operating
Instructions →   11

Setting up the IP address of the Field Controller SFC162
1. Set the IP address of the computer to the same domain as the Field Controller

SFC162's default address 192.168.164.100.

2. If you have Application Designer installed on your computer, call HSE Network
Setup:
Select Programs → Endress+Hauser → ControlCare → Tools → HSE Network Setup.
Otherwise call up the Web server and enter the address 192.168.164.100 . Then
proceed with Step 5.
 HSE Network Setup is launched and searches for devices in the Ethernet

network.

All devices in the network appear, irrespective of their IP domain. If this is not
the case:
Check that the proxy server of the Web browser is switched off.
Check that the Windows firewall is not blocking the program (switch off the
firewall).
Check all cables and switches.
If two or more Field Controllers with the same IP address are found, disconnect
all but one from the network.

3. If the computer has more than one NIC, it is necessary to select the card you want to
use for communication with the Field Controllers.
Tick Active NIC and click Save.

4. Note the IP address of the active card as this is used by FieldCare.
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5. Double-click the Field Controller whose address is to be changed or enter
192.168.164.100 in the Web browser.
 The Web browser of the Field Controller opens.

The Web server only opens if the host computer and the Field Controller have
IP addresses in the same IP domain.
If the Web server still does not open, make sure that the proxy server of the
browser has been disabled.

6. Expand the "Setup" node and click Network.

7. Enter pcps as the user name and pcps as the password.
 The "Network Configuration" dialog opens.

8. Enter the required IP address (e.g. 10.125.35.190).

9. Enter a netmask (e.g. 255.0.0.0., but usually 255.255.255.0).

10. If required, enter a default gateway (usually xxx.xxx.xxx.1 selected domain) and
click Update.

11. Confirm the message stating that the Field Controller SFC162 must be restarted.

The IP address is changed.

34.2.2  Select Visitor mode
There can be up to four Field Controller SFC162s in any one network. However, each
controller must be assigned a different H1 address by running the option under Step
2 above.
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Selecting the Visitor mode
1. Return to the home page and click Change.

 The frameware home screen opens.

2. Select the Factory Init in Visitor Mode (H1 Address 0xFC) option and click Restart.

3. Enter pcps as the user name and pcps as the password to confirm the Field
Controller SFC162 restart.
 The Field Controller SFC162 changes its mode from Controller (default setting)

to Visitor.
The Field Controller is restarted as Visitor.

4. Set the address of the host computer to the same domain as that of the Field
Controller SFC162 Visitor (e.g. 10.125.35.200).

34.2.3  Selecting the network interface card (NIC) for FieldCare
If the host computer has more than one NIC, the one used for the Ethernet connection
to the controller and visitor must be specified, otherwise the applications running on
Ethernet select the first they find by default. For Application Designer, ticking and
storing the active NIC in HSE Network Setup causes the associated .ini files to be
updated.

For FieldCare these changes have to be made by hand.

Selecting the network interface card (NIC) for FieldCare
1. Select Program Files → Common Files →Codewrights → HSEsvr2 →

endressoleserver.ini.
2. Open the endressoleserver.ini file with Notepad.

3. Search for the "NIC Adapter" entry.

4. Set a ; in front of the line DEFAULT_NIC = NIC.

5. Remove the ; from the line NIC = and add the NIC address (e.g. NIC =
10.125.35.200).


6. Save and close the endressoleserver.ini file.

The Visitor Function can now be used.
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34.3  Connection procedure

34.3.1  Connection with the Field Controller SFC162 CommDTM

Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the SFC162 CommDTM item and click OK.
 The SFGNetwork is added to the network.

5. In the "Network" dialog, right-click SFC162 CommDTM.
 A drop-down list opens.

6. Select Configuration.
 FieldCare scans the network for all the Ethernet devices and displays them in the

list of HSE devices.

7. To connect the Field Controller SFC162 Visitor, click the appropriate line (e.g.
10.125.35.190).
 A tick appears next to the Field Controller SFC162 Visitor and the entry appears

green.
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34.3.2  Assigning the device tag or H1 address

Assigning the device tag or address
1. In the "Network" dialog, right-click SFC162 CommDTM.

 A drop-down list opens.

2. Select Connect.
 The arrows next to the device appear green.

3. In the "Network" dialog, right-click SFC162 CommDTM.
 A drop-down list opens.

4. Select Other Functions → Set Device Tag/Address.
 The list of H1 devices is displayed.

5. Click the device (e.g. TMT162).
 The input boxes at the bottom edge of the page are activated.

6. Enter the device tag.
 The tag is changed in the list and the entry is set to red.

7. Enter the device address.
 The address is changed in the list and the entry is set to red.

8. Click Apply.
 Changes are saved and downloaded to the device.
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The icon at the start of the line appears in full color if the changes are accepted.

• If there are more devices in the network, the tags and addresses of all participants
can be changed before Apply is pressed.

• When all devices return to the network, the H1 list can be closed.

34.3.3  Creating a FOUNDATION Fieldbus network

Creating a FOUNDATION Fieldbus network
1. In the "Network" dialog, right-click SFC162 CommDTM.

 A drop-down list opens.

2. Select Create Network.
 The "Select Communication Channel" dialog opens.

3. Select the channels to be scanned. Deselect all other channels and click OK.
 Scanning starts.

FieldCare scans the selected channels and adds the devices found to the network.

34.3.4  Opening the DeviceDTM

Opening the DeviceDTM
1. In the "Network" dialog, right-click a device.

 A drop-down list opens.

2. Select Connect.
 The arrows next to the device appear green.
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3. In the "Network" dialog, right-click a device.
 A drop-down list opens.

4. Select Online Parameterize.
 The DeviceDTM is added to the network tree and the DTM opens.

The device can now be configured.

For detailed information on "Field Controller SFC162 Visitor": Operating Instructions
→   11

34.4  Upload the project
After the devices have been configured, their settings must be uploaded to the Field
Controller SFC162 and engineering tool. Depending upon the tool and the task
(commissioning or replacement) this can be normally done for the entire fieldbus or for
individual devices.
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35  FOUNDATION Fieldbus H1 via the National
Instruments FBUS card

35.1  Use cases
The National Instruments PCPC-FBUS card allows a computer or laptop with a PC interface
to connect to a FOUNDATION Fieldbus H1 segment.

The National Instruments software delivered with the card must be installed on the
computer, configured and ready for use.

If the PC-FBUS card is connected to an active FOUNDATION Fieldbus H1 segment, it is
important to read the manufacturer's instructions with regard to uploading modified
device settings to the controller.

To see all the devices on the FOUNDATION Fieldbus H1 segment, FieldCare requires:
• FOUNDATION Fieldbus CommDTM
• FOUNDATION Fieldbus DeviceDTMs
• For devices without native DTMs, the iDTM for FOUNDATION Fieldbus

35.1.1  Connection to a FOUNDATION Fieldbus H1 segment
To connect the PC-FBUS card to a FOUNDATION Fieldbus H1 segment, the positive and
negative signal cables from the NI adapter piece must be connected to the bus line, e.g. via
a bus distributor.

1 2 3 4 5 6

 47 Connection of an NI-PC-FBUS card to a FOUNDATION Fieldbus H1 segment

1 DCS
2 Adapter
3 Adapter cable
4 NI-PC-FBUS card
5 FieldCare
6 FOUNDATION Fieldbus H1

35.1.2  Point-to-point connection in Bench mode
In Bench mode, the devices are connected to the NI-PC-NBS card one by one in order to
configure the device address and device parameters. This requires a bus distributor,
for example, with a fieldbus power supply.
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1 2 3 4 5 6

 48 Use of the NI-PC-NBS card in Bench mode

1 FOUNDATION Fieldbus H1
2 Power conditioner/bus distributor
3 Adapter
4 Adapter cable
5 NI-PC-NBS card
6 FieldCare

35.2  Connection procedure
‣ Click Start → Programs →National Instruments → NI-FBUS → NI-FBUS

Communications Manager.
 The NI card opens.

Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.
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4. Select the FF H1 CommDTM item and click OK.
 The FF H1 CommDTM is added to the network.

5. In the "Network" dialog, right-click FF H1 CommDTM.
 A drop-down list opens.

6. Select Configuration.
 The "FF H1 CommDTM" dialog opens and FieldCare asks for the link to the

FOUNDATION Fieldbus network.

7. Select the NI Card Link from the drop-down menu and click OK.

8. In the "Network" dialog, right-click FF H1 CommDTM.
 A drop-down list opens.

9. Select Create Network.
 FieldCare now scans the network.

The DeviceDTM is added to the network and opened.

10. Save the project →   13.

The project is saved.

If FieldCare cannot find the correct DTM, it will offer alternative versions, graded
according to their suitability in the "Scan Result" dialog. The user has the choice of
accepting a DTM of less quality, or canceling the scan.

If no new DTM is available, the user can still integrate the device by using the HART
iDTM.

1. The DTMs are opened as follows if the NI FBUS card is connected to a FOUNDATION
Fieldbus H1 segment and several devices are found:
In the "Network" dialog, right-click Device Node.
 A drop-down list opens.

2. Select Connect.

3. In the "Network" dialog, right-click Device Node.
 A drop-down list opens.

4. Select Online Parameterize.
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36  FOUNDATION Fieldbus H1 via Softing FFusb
modem

36.1  Use cases
The Softing FFusb modem allows a computer or laptop to connect to a
FOUNDATION Fieldbus H1 segment via USB.

Install the Softing FFusb software on the computer before the USB connection is made
(the software can also be downloaded from the Softing site).

The FFusb CommDTM must be licensed, otherwise it only runs for 15 minutes in
demonstration mode.

The FieldCare DTM catalog must be updated.

If the FFusb modem is connected to an active FOUNDATION Fieldbus H1 segment, it
is important to read the manufacturer's instructions with regard to uploading
modified device settings to the controller.

To see all the devices on the FOUNDATION Fieldbus H1 segment, FieldCare requires:
• FFusb CommDTM
• FOUNDATION Fieldbus DeviceDTMs
• For devices without native DTMs, the iDTM for FOUNDATION Fieldbus

36.1.1  Connection to a FOUNDATION Fieldbus H1 segment
To connect the FFusb modem to a FOUNDATION Fieldbus H1 segment, the positive and
negative signal cables must be connected to the bus line, e.g. via a bus distributor.

1 2 3 4 5

 49 Connection of an FFusb modem to a FOUNDATION Fieldbus H1 segment

1 DCS
2 FFusb modem
3 USB
4 FieldCare
5 FOUNDATION Fieldbus H1

36.1.2  Point-to-point connection in Bench mode
In Bench mode, the devices are connected to the FFusb modem one by one in order to
configure the device address and device parameters. This requires a bus distributor,
for example, with a fieldbus power supply.
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1 2 3 4 5

 50 Use of the FFusb modem in Bench mode

1 FOUNDATION Fieldbus H1
2 Power conditioner/bus distributor
3 FFusb modem
4 USB
5 FieldCare

36.2  Connection procedure
Before establishing a connection:
• Install the FFusb software
• Connect the FFusb modem to the USB port

Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.
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4. Select FF USB and click OK.
 The FF USB CommDTM is added to the network.

5. In the "Network" dialog, right-click FF USB.
 A drop-down list opens.

6. Select Configuration.
 The standard parameters for a FOUNDATION Fieldbus Visitor open.

7. Change the scan range to suit the addresses on the segment.

8. Other parameters should be changed by a fieldbus expert only.
Click OK.
 The changes are accepted and the "Network" dialog opens.

9. Right-click FF USB.
 A drop-down list opens.

10. Select Create Network.
 The DeviceDTM is added to the network and opens.

11. Save the project →   13.
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The project is saved.

If FieldCare cannot find the correct DTM, it will offer alternative versions, graded
according to their suitability in the "Scan Result" dialog. The user has the choice of
accepting a DTM of less quality, or canceling the scan.

If no new DTM is available, the user can still integrate the device by using the HART
iDTM.

1. The DTMs are opened as follows if the NI FBUS card is connected to a FOUNDATION
Fieldbus H1 segment and several devices have been found:
In the "Network" dialog, right-click Device Node.
 A drop-down list opens.

2. Select Connect.

3. In the "Network" dialog, right-click Device Node.
 A drop-down list opens.

4. Select Online Parameterize.
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37  ISS interface via FXA193 modem

37.1  Use case
The FXA193 modem provides a direct connection to Proline flowmeters.

The connection socket for communication can either be found inside the electronic
housing or the connection housing. Please consult the appropriate Operating Instructions
for further details. The following graphic shows the necessary connections.

TX

RX

G

5V

1 2 3 5 64

 51 ISS interface connection using FXA193 modem

1 FieldCare
2 RS232
3 FXA193 modem
4 Cable and adapter
5 Proline flowmeter electronic compartment or connection compartment
6 Power supply

The FXA193 modem must be used with the so-called Proline cable, which comprises two
components: a cable and an adapter.

The FXA193 modem is a serial modem with a Sub-D9 connector. It is recommended that
only a native serial port be used. The use of USB/Serial converters is not recommended. If
the desktop computer has no RS232 serial port, it is recommended that either a PCI or a
PCIe card be used. For laptop computers either a PC or Express Card can be used.

To connect to flow devices via the protocol (ISS), FieldCare requires:
• ISS CommDTM
• ISS DeviceDTM library

37.2  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the Flow Communication FXA193/291 item and click OK.
 The Flow Communication FXA193/291 is added to the network.

5. In the "Network" dialog, right-click Flow CommDTM.
 A drop-down list opens.

6. Select Configuration.
 The "Flow Communication FXA193/291 (Configuration)" dialog opens.

7. Set the COM port to which the FXA193 modem is to be connected and then press
Enter.
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8. Click the X in the top right.
 The "Flow Communication FXA193/291 (Configuration)" dialog closes and the

"Network" dialog opens.

9. Right-click Flow CommDTM.
 A drop-down list opens.

10. Select Create Network.
 FieldCare scans the network and indicates the result. The DeviceDTM is added to

the network.

11. Configure the device according to its Operating Instructions.

Save the project →   13.

If no DeviceDTM is installed, FieldCare states that proper communication can only be
ensured after the DTM has been installed.

There is no possibility to connect to the device automatically if the matching DTM is
not installed.

Manually connecting to the device:
– Right-click Device and select Connect
– Right-click Device and select Online Parameterize
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38  ISS interface via FXA291 modem

38.1  Use case
Some older flowmeters do not use the connector shown in the previous graphic.

In this case the FXA291 modem must be used to connect to FieldCare. The connection
socket for communication can either be found inside the electronic housing or the
connection housing. Please consult the appropriate Operating Instructions for further
details. The following graphic shows the necessary connections.
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 52 ISS interface connection using FXA291 modem

1 FieldCare
2 USB
3 FXA291 modem
4 Cable and adapter
5 Proline flowmeter electronic compartment or connection compartment
6 Power supply

To connect to flow devices via the protocol (ISS), FieldCare requires:
• CommDTM
• DeviceDTM library

38.2  Connection procedure
Normally the computer automatically recognizes the FXA291 modem. If this is not
the case, the driver must be installed →   178.

FieldCare establishes a connection to the FXA291 modem as described in Chapter
37.2 →   155.
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39  IPC interface for level/pressure via FXA193
modem

The IPC interface does not apply for all level devices. Information on this can be found
in the Operating Instructions for the device in question.

39.1  Use case
For communication with level and pressure devices via the IPC protocol, connectivity is
provided with the FXA193 modem in combination with the so called ToF cable.

The connection socket for communication is the same as the one used to connect the
device display. Please consult the appropriate Operating Instructions for further details.
The following graphic shows the necessary connections.

1 2 3 5 64

 53 IPC interface connection using FXA193 modem

1 FieldCare
2 RS232
3 FXA193 modem
4 Cable and adapter
5 Level or pressure device display connection compartment
6 Power supply

The FXA193 modem is a serial modem with a Sub-D9 connector. For this application it can
be connected to either a native serial port or a USB/serial converter. To connect to devices
via the IPC protocol, FieldCare requires:
• IPC CommDTM
• IPC DTM library

39.2  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the IPC FXA193/291 item and click OK.
 The IPC CommDTM is added to the network.

5. In the "Network" dialog, right-click IPC DTM.
 A drop-down list opens.

6. Select Configuration.
 The "IPC FXA193/291 (Configuration)" dialog opens.

7. Set the COM port to which the FXA193 modem is to be connected.
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8. Press Enter and then click the X in the top right.
 The "IPC FXA193/291 (Configuration)" dialog closes and the "Network" dialog

opens.

9. In the "Network" dialog, right-click IPC CommDTM.
 A drop-down list opens.

10. Select Create Network.
 FieldCare scans the network and indicates the result. The DeviceDTM is added to

the network.

11. Configure the device according to its Operating Instructions.

Save the project →   13.

If no DeviceDTM is installed, FieldCare states that proper communication can only be
ensured after the DTM has been installed.

There is no possibility to connect to the device automatically if the matching DTM is
not installed.

Manually connecting to the device:
– Right-click Device and select Connect
– Right-click Device and select Online Parameterize
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40  IPC interface for level/pressure via FXA291
modem

The IPC interface does not apply for all level devices. Information on this can be found
in the Operating Instructions for the device in question.

40.1  Use case
For communication with level and pressure devices via the IPC protocol, connectivity can
be provided with the FXA291 modem in combination with the so called ToF cable.

The connection socket for communication is the same as the one used to connect the
device display. Please consult the appropriate Operating Instructions for further details.
The following graphic shows the necessary connections.

1 2 3 5 64

 54 IPC interface connection using FXA291 modem

1 FieldCare
2 USB
3 FXA291 modem
4 Cable and adapter
5 Level or pressure device display connection compartment
6 Power supply

To connect to devices via the IPC protocol, FieldCare requires:
• IPC CommDTM
• IPC DTM library

40.2  Connection procedure
Normally the computer automatically recognizes the FXA291 modem. If this is not
the case, the driver must be installed →   178.

FieldCare establishes a connection to the FXA291 modem as described in Chapter
39.2 →   159.
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41  CDI interface via FXA291 modem

41.1  Use case
All new and projected Endress+Hauser field devices use CDI communication as standard
for the protocol. The FXA291 modem provides connectivity to all Endress+Hauser devices
using the so called CDI plug. The following graphic shows the necessary connections.
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 55 CDI interface connection using FXA291 modem

1 FieldCare
2 USB
3 FXA291 modem
4 Cable and adapter
5 Proline flowmeter electronic compartment or connection compartment
6 Power supply

To connect to devices via the CDI protocol, FieldCare requires:
• CDI CommDTM
• CDI DTM library

41.2  Connection procedure
Normally the computer automatically recognizes the FXA291 modem. If this is not
the case, the driver must be installed →   178.

Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the CDI Communication FXA291 item and click OK.
 The CDI Communication FXA291 is added to the network.

5. In the "Network" dialog, right-click CDI Communication FXA291.
 A drop-down list opens.

6. Select Configuration.
 The "CDI Communication FXA291 (Configuration)" dialog opens.

7. Set the COM port to which the FXA291 modem is to be connected and then press
Enter.
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8. Do not change the baud rate unless this is explicitly required in the Operating
Instructions for the device.

9. Click the X in the top right.
 The "CDI Communication FXA291 (Configuration)" dialog closes and the

"Network" dialog opens.

10. In the "Network" dialog, right-click CDI Communication FXA291 (Communication).
 A drop-down list opens.

11. Select Create Network.
 FieldCare scans the network and indicates the result. The DeviceDTM is added to

the network.

12. Configure the device according to its Operating Instructions.

13. Save the project →   13.

The project is saved.

If no DeviceDTM is installed, FieldCare states that proper communication can only be
ensured after the DTM has been installed.

There is no possibility to connect to the device automatically if the matching DTM is
not installed.

Manually connecting to the device:
– Right-click Device and select Connect
– Right-click Device and select Online Parameterize
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42  CDI interface via TXU10 modem

42.1  Use case
The TXU10 modem is a USB/CDI modem that may be used with FieldCare for configuring
the following devices:
• RIA45/46, RMA42, RIA14/16, all new and projected devices
• Together with M12 adapter: TMR3x

Devices without digital communication such as TMT180/181/121, TTR3x, PTP3x, PTC31,
DTT3x, RIA452, RIA141, TMT111 and TMR31x (with M12 adapter) cannot be configured
by FieldCare but require the Readwin2000 software, which can be optionally purchased
with the modem. See the Readwin2000 BA137R/09/en manual for more information.
The FXA291 modem provides connectivity to all Endress+Hauser devices using the so
called CDI plug. The following graphic shows the necessary connections.
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 56 CDI interface connection using TXU10 modem

1 FieldCare
2 USB
3 TXU10 modem
4 Cable
5 Indicators, process transmitter or TMT3x (with M12 adapter)
6 Power supply

To connect to devices via the CDI interface, FieldCare requires:
• CDI CommDTM
• CDI DTM library

42.2  Connection procedure
Normally the computer automatically recognizes the FXA291 modem. If this is not
the case, the driver must be installed →   178.

Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the CDI Communication FXA291 item and click OK.
 The CDI Communication FXA291 is added to the network.

5. In the "Network" dialog, right-click CDI Communication FXA291.
 A drop-down list opens.

6. Select Configuration.
 The "CDI Communication FXA291 (Configuration)" dialog opens.

7. Set the COM port to which the FXA291 modem is to be connected and then press
Enter.
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8. Do not change the baud rate unless this is explicitly required in the Operating
Instructions for the device.

9. Click the X in the top right.
 The "CDI Communication FXA291 (Configuration)" dialog closes and the

"Network" dialog opens.

10. Right-click CDI Communication FXA291.
 A drop-down list opens.

11. Select Create Network.
 FieldCare scans the network and indicates the result. The DeviceDTM is added to

the network.

12. Configure the device according to its Operating Instructions.

13. Save the project →   13.

The project is saved.

If no DeviceDTM is installed, FieldCare states that proper communication can only be
ensured after the DTM has been installed.

There is no possibility to connect to the device automatically if the matching DTM is
not installed.

Manually connecting to the device:
– Right-click Device and select Connect
– Right-click Device and select Online Parameterize
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43  CDI interface via direct USB connection

43.1  Use case
A number of CDI capable field devices can be connected directly to a computer via an
standard USB (A-B) cable. Currently these are:
• EngyCal
• RA33
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 57 CDI interface connection via direct USB connection

1 FieldCare
2 USB
3 Cable
4 EngyCal, RA33
5 Power supply

To connect to devices via the CDI interface, FieldCare requires:
• CDI CommDTM
• CDI DTM library

43.2  Connection procedure
Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.
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3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the CDI Communication USB item and click OK.
 The CDI Communication USB is added to the network.

5. Connect the CDI-USB to the computer or laptop.
 When the USB device is connected for the first time, the driver (CDIUSB) is

installed.
This installation does not require administration rights.

6. In the "Network" dialog, right-click CDI Communication USB.
 A drop-down list opens.

7. Select Create Network.
 FieldCare scans the network and indicates the result. The DeviceDTM is added to

the network.

8. Configure the device according to its Operating Instructions.

9. Save the project →   13.

The project is saved.

If no DeviceDTM is installed, FieldCare states that proper communication can only be
ensured after the DTM has been installed.

There is no possibility to connect to the device automatically if the matching DTM is
not installed.

Manually connecting to the device:
– Right-click Device and select Connect
– Right-click Device and select Online Parameterize



Tutorial for FieldCare projects CDI interface via Ethernet TCP/IP

Endress+Hauser 171

44  CDI interface via Ethernet TCP/IP

44.1  Use case
A number of CDI capable field devices can be connected directly to a computer via a
standard Ethernet cross-cable with RJ45 connector. Examples include:
• Promass 100
• Promag 100
• Promag 400

The following graphic shows the necessary connections. If the connection is made via a
switch a straight-through cable can be used. For the location of the Ethernet interface,
please see the Operating Instructions of the device concerned.
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 58 CDI interface via direct Ethernet connection

1 FieldCare
2 Ethernet
3 Category 5 cross-cable
4 Device e.g. Promass 100, Promag 400
5 Power supply

To connect to devices via the CDI interface, FieldCare requires:
• CDI CommDTM
• CDI DTM library

44.2  Setting up the computer
When using the Ethernet TCP/IP connection it is important to note that the computer and
device must have IP addresses within the same domain.

Computer setup

‣ Change the computer's IP address to the same IP address range and subnet mask as
the default address of the device. The procedure for Windows 7 is described in
Appendix A.

The computer is set up.

If the IP address of the device is changed during the configuration, FieldCare will lose
contact with the device. In this case, it is necessary to change the computer's address
to an address in the new domain and then restart the application.

44.3  Connection procedure
When using the Ethernet TCP/IP connection it is important to note that the computer
and device must have IP addresses within the same domain.

For detailed information on "FieldCare SFE500 - Setting up the IP address": Operating
Instructions →   11
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Establishing a connection
1. Create a project →   13.

2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.

4. Select the CDI Communication TCP/IP item and click OK.
 The CDI Communication TCP/IP is added to the network.

5. In the "Network" dialog, right-click CDI Communication TCP/IP.
 A drop-down list opens.
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6. Select Add Device.
 The "Add New Device" dialog opens.

7. Select DeviceDTM and click OK.
 The DeviceDTM is added to the network and the "CDI Communication TCP/IP

(Configuration)" dialog opens.

8. Specify the IP address of the device which the computer is connected to and then
press Enter.

9. Change the port and then press Enter.
 The changes are accepted.

10. Click the X in the top right.
 The "CDI Communication TCP/IP (Configuration)" dialog closes and the "Network"

dialog opens.

11. Connect the device to the computer via the Ethernet cable.

12. In the "Network" dialog, right-click CDI Communication TCP/IP.
 A drop-down list opens.

13. Select Connect.
 The arrows next to the device appear green.
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14. In the "Network" dialog, right-click a device node.
 A drop-down list opens.

15. Select Connect.
 The arrows next to the device appear green.

16. In the "Network" dialog, right-click a device node.
 A drop-down list opens.

17. Select Online Parameterize.
 The DeviceDTM opens in the online mode.

18. Configure the device according to its Operating Instructions.

19. Save the project →   13.

The project is saved.

Check the following if the device does not connect to FieldCare:
• The computer and the device must have the same IP addresses in the same range
• The Ethernet cable must be suitable for the connection used
• Use the correct DTM
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45  PCP interfaces via the FXA291/TXU10 modem

45.1  Use case
The TXU10 or FXA291 modem may also be used with FieldCare for configuring the
following devices:
• Thermophant
• Ceraphant
• Flowphant
• RIA1x
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 59 PCP interface connection using a TXU10 modem

1 FieldCare
2 USB
3 TXU10 modem
4 Cable
5 Type
6 Power supply
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 60 PCP interface connection using an FXA291 modem

1 FieldCare
2 USB
3 FXA291 modem
4 Cable and adapter
5 Type
6 Power supply

To connect to devices via the PCP protocol, FieldCare requires:
• PCP CommDTM
• PCP DTM library

45.2  Connection procedure
Normally the computer automatically recognizes the FXA291 modem. If this is not
the case, the driver must be installed →   178.

Establishing a connection
1. Create a project →   13.
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2. In the "Network" dialog, right-click Host PC.
 A drop-down list opens.

3. Select Add Device.
 The "Add New Device" dialog opens.

1. Select the PCP TXU10/FXA291 item and click OK.
 The PCP TXU10/FXA291 is added to the network.

2. In the "Network" dialog, right-click PCP TXU10/FXA291.
 A drop-down list opens.

3. Select Configuration.
 The "PCP TXU10/FXA291" dialog opens.
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4. Set the COM port to which the TXU10/FXA291 modem is to be connected and then
press Enter.

5. Set the number of retries (for example to 3) and then press Enter.

6. Change the device address.

7. Change the baud rate if this is explicitly required in the Operating Instructions for
the device.

8. Click the X in the top right.
 The "PCP TXU10/FXA291" dialog closes and the "Network" dialog opens.

9. In the "Network" dialog, right-click PCP TXU10/FXA291.
 A drop-down list opens.

10. Select Create Network.
 FieldCare scans the network and indicates the result. The DeviceDTM is added to

the network.

11. Configure the device according to its Operating Instructions.

12. Save the project →   13.

The project is saved.

If no DeviceDTM is installed, FieldCare states that proper communication can only be
ensured after the DTM has been installed.

There is no possibility to connect to the device automatically if the matching DTM is
not installed.

Manually connecting to the device:
– Right-click Device and select Connect
– Right-click Device and select Online Parameterize
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46  Appendix

46.1  Appendix A - Installing a USB modem driver
Before the modem can be used, the USB modem driver must be installed on the computer.

Installing the modem driver
1. Connect the connector of the modem to the corresponding port.

 The computer detects the modem as a new piece of hardware.
The "Found New Hardware" message opens.

2. Select the No, Not This Time option and click Next.

3. Click Next.

4. Insert the DVD delivered with the modem into the DVD drive and click Next.
 Follow the instructions of the wizard to install the modem as external hardware.

5. Unplug the USB connector when the installation is finished.

6. Restart the computer.
 When the USB connector is plugged into the computer again the modem will be

recognized.

7. To check the COM port, select Settings → Control Panel → System.

8. Click Device Manager.

9. Open the Ports (COM and LPT) node.
 COM port opens.

The USB modem driver is installed.

46.2  Appendix B - Replacing the iDTM with a DeviceDTM
iDTM allows the integration of devices that have no appropriate DTM available. It has,
however, less functionality than a DTM.

If appropriate DTMs become available, the devices that were integrated into the FieldCare
project with the iDTM can be operated with this DTM. For this purpose, the iDTM must be
replaced with the DeviceDTM.

After replacement, the saved information of the iDTM must be entered again
manually in the new DTM.

For detailed information on "FieldCare: Installation of DTM library: Getting Started
→   11

For detailed information on "FieldCare: Updating the DTM catalog": Getting Started
→   11

Replacing an iDTM with a DeviceDTM
1. Install the DTM.

2. Update the FieldCare DTM catalog.

3. In the "Network" dialog, right-click a device node.
 A drop-down list opens.
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4. Select Device Type (DTM) Info.
 The "Device Type (DTM) Information" dialog opens.

A list of all the suitable DTMs appears.

5. Select the DeviceDTM.

6. If the DTM should be replaced for several devices:
Tick the Save Assignment for All Devices of Same Type check box and click OK.
 The "Assign Device Type (DTM)" dialog opens.

7. Click Yes.
 The "Device Type (DTM) Information" dialog opens.

8. Click OK.
 The changes are accepted.

The iDTM has been replaced by the DeviceDTM.

46.3  Appendix C - PROFIBUS PA Profile
If no native DeviceDTMs are available for devices up to PA Profile 3.0, it is possible to use a
PROFIBUS PA Profile. The following profiles are available for the devices:
• Actuator Profile DTM
• Discrete Input Profile DTM
• Discrete Output Profile DTM
• Flow Profile DTM
• Level Profile DTM
• Pressure Profile DTM

 61 Pressure Profile DTM
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46.4  Appendix D - Generic HART
If a native DeviceDTM is not available for HART/HART7, the Generic HART DTM can be
used.

The Generic HART DTM has the following options:
• Identify device
• Configure device
• Trend values with archive function
• Device diagnosis
• Device calibration

For more details, please refer to the online help of the Generic HART DTM.

 62 Generic HART DTMs

46.5  Appendix E - Fieldgate SFG500 error information
All the devices connected to the PROFIBUS are displayed in the Fieldgate SFG500 Web
application. Detailed information about the cause of the error can be displayed here. The
Web application can be started in FieldCare:

1. In the "Network" dialog, right-click to select the SFG500 item. The SFG500 must be
online for this (green background)
 A drop-down list opens.

2. Select the Additional Functions → Embedded Webserver item.

The SFG500 Web application not only displays the PROFIBUS devices in a livelist but also
the HART devices behind Remote I/Os (ET200M/iSP, Stahl IS1, Turck excom, ABB S900)
and also PROFIBUS PA devices behind Siemens Link.

If HART/PA devices are not recognized when scanning or connecting, the user can check
here whether the devices are even on the bus or whether the Remote I/Os have been
configured.

Detailed information can be displayed for every entry.
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Remote I/O devices
Remote I/O devices must generally be configured by a cyclic master for it to be possible to
scan for HART devices.

Multiple remote I/O devices cannot be operated on the bus with two acyclic masters.
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